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Objetivo general: 
 

Proveer a los participantes de una metodología probada y consistente en 

técnicas y herramientas para la correcta y adecuada administración de 

proyectos gubernamentales. 

 

 

Objetivos Específicos: 

 Contribuir Efectivamente a Generar Valor Económico, al Administrar 

con Eficacia y Eficiencia, los Proyectos en las Dependencias 

Gubernamentales. 

 Conocer las Herramientas para Elaborar PPI´s y Optimizar la Ejecución 

de los Proyectos Asignados. 

 Utilizar el paquete MS Project (versión 2007) como apoyo en la 

administración de los proyectos 

 

 
Duración:  20 hrs.  
 
Fechas:   27 y 28 de octubre de 2011 
 
Instructor:  Dr. Primitivo Reyes Aguilar 
 
Sede:   IPN – CENTRO DE EDUCACIÓN CONTINUA MAZATLÁN 
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1. La administración de proyectos 

1.1 Introducción 

a) Definición de proyecto 

Proyecto es un proceso único que consiste en un conjunto de actividades coordinadas y 

controladas con fecha de inicio y de terminación, realizadas para alcanzar un objetivo, 

incluyendo restricciones de tiempo, costos y recursos (ISO 10006). 

 

Otras definiciones 

 Es un esfuerzo temporal que se lleva a cabo para crear un resultado único (PMBOK). 

 Es el proceso completo para producir un nuevo producto, instalar una planta nueva, 

instalar un nuevo sistema u otros resultados especificados 

 Es una actividad muy definida planeada con una duración determinada y con una meta 

específica a alcanzar 

 Es la búsqueda de una solución inteligente al planteamiento de un problema tendiente 

a resolver, entre muchas, una necesidad humana. 

 Es una serie de planteamientos encaminados a la producción de un bien o la 

prestación de un servicio, con el empleo de una cierta metodología o técnica y con 

miras a obtener un determinado resultado, desarrollo económico o beneficio social. 

 
http://www.wcpm.co.uk/epmbook/projdefwhy.htm 

b) Características de los proyectos 

Un proyecto debe formularse cuidadosamente considerando todos los aspectos y riesgos. 

Para tomar la decisión de emprender o no un proyecto, debe realizarse un análisis 

cuidadoso y multidisciplinario considerando ventajas y riesgos, esto es la Evaluación del 

Proyecto. 

http://www.wcpm.co.uk/epmbook/projdefwhy.htm
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 La elaboración del proyecto es gradual, ya que se desarrolla en pasos o 

incrementos. Por ejemplo para una planta química, se define en general el 

alcance del proyecto y se hace más explicito a medida que el equipo de 

proyectos desarrolla una mejor comprensión de los entregables (PMBOK). 

 En algunos proyectos, se perfeccionan el o los objetivos y las características del 

producto se definen progresivamente a medida que avanza el proyecto. 

 Un proyecto individual puede formar parte de una estructura de proyectos 

mayor. 

 El resultado del proyecto puede ser una o varias unidades de producto. 

 La organización es temporal y se establece por la duración del proyecto. 

 Las interacciones sobre las actividades del proyecto pueden ser complejas. 

 

 
http://www.eluniversal.com.mx/notas/677827.html 

 

Los proyectos difieren de las operaciones en que estas son continuas y repetitivas, 

mientras que los proyectos son temporales y únicos. Aunque comparten varias de las 

siguientes características: se realizan por personas, están restringidos por la limitación de 

recursos y se planifican, ejecutan y controlan. 

 

La importancia que tiene el estudio de los proyectos es disponer de los antecedentes y la 

información necesarios que permitan asignar en forma racional los recursos escasos a la 

alternativa de solución más eficiente y viable frente a una necesidad.  

 

Los proyectos de alguna manera se han realizado desde la antigüedad (pirámides): 

http://www.eluniversal.com.mx/notas/677827.html
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http://www.re-moto.com/photos.php?lang=esp&img=4237 

c) Importancia de los proyectos 

Los proyectos son importantes porque eliminan los problemas o mejoran los procesos. 

Entre mayor sea el problema (u oportunidad), más importante será el proyecto y la 

organización más dispuesta a comprometer recursos. Las restricciones pueden cambiar 

durante el proyecto, por ejemplo si un rayo destruye los sistemas de cómputo, la 

prioridad ahora se centra en el tiempo de restauración y no en el costo.   

 

Los cinco pasos típicos de la Administración de proyectos son: 
 

Pasos Procesos y resultados 

Definir Definición de Metas, objetivos y alcance; identificación de 
restricciones del proyecto; estimación de riesgos; establecimiento 
de compromisos del proyecto; inicio del proyecto. 
 

Planear Identificación de Actividades; duración estimada; Identificación  de 
recursos; estimación de costos; tareas secuenciadas; preparación 
de programas; creación de presupuestos; Identificación de riesgos; 
asignación de recursos; luz verde confirmada. 
 

Implementar Dirección del Proyecto; surtimiento de suministros; realización de 
comunicaciones; ejecución de actividades de trabajo. 
 

Controlar Seguimiento a avances, calidad y costos; Identificación y solución 
de problemas; realización de acciones correctivas conforme sea 
necesario. 
 

Cerrar Aceptación del trabajo; contratos cerrados; reasignación de la 
organización de apoyo (staff); revisión y evaluación del proyecto. 

http://www.re-moto.com/photos.php?lang=esp&img=4237
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d) Comprensión del entorno del proyecto  

Casi todos los proyectos se planifican e implementan en un contexto social, económico y 

ambiental y tienen impactos positivos y negativos deseados y/o no deseados. El equipo 

del proyecto debe considerar el proyecto en el contexto de su entorno cultural, social, 

internacional, político y físico.  

 

• Entorno cultural y social. El equipo tiene que entender cómo afecta el proyecto a las 

personas y cómo afectan las personas al proyecto. Esto puede requerir una comprensión 

de los aspectos económicos, demográficos, educativos, éticos, étnicos, religiosos, y de 

otras características de las personas a quienes afecta el proyecto o que puedan tener un 

interés en éste. El director del proyecto también debe examinar la cultura de la 

organización y determinar si se reconoce que la administración de proyectos desempeña 

un rol válido con responsabilidad y autoridad para gestionar el proyecto.  

 

• Entorno internacional y político. Es posible que algunos miembros del equipo tengan 

que estar familiarizados con las leyes y costumbres internacionales, nacionales, regionales 

y locales aplicables, así como con el clima político que podría afectar al proyecto.  

 

• Entorno físico. Si el proyecto va a afectar a su ámbito físico, algunos miembros del 

equipo deberán estar familiarizados con la ecología local y la geografía física que podrían 

afectar al proyecto o ser afectadas por el proyecto.  

 

Los factores ambientales de la organización se refieren a elementos tangibles e 

intangibles, tanto internos como externos que rodean el éxito de un proyecto o influyen 

en él. Estos factores pueden provenir de cualquiera de las empresas implicadas en el 

proyecto y pueden influir de manera positiva o negativa sobre el resultado.  Se consideran 

entradas para la mayoría de los procesos de planificación e incluyen: 

 

•  Procesos, estructura y cultura de la organización; normas de la industria o 

gubernamentales (por ej., regulaciones del organismo de control, códigos de conducta, 

normas de calidad); 

•  infraestructura (por ej., instalaciones existentes y bienes de capital); 

•  recursos humanos existentes (por ej., habilidades, disciplinas y conocimientos 

como los relacionados con desarrollo, las leyes, las contrataciones y las compras); 

•  administración de personal (por ej., pautas de retención y manejo de personal, 

revisión del desempeño de los empleados y registros de capacitación); 

•  sistemas de autorización de trabajos de la institución; 

•  condiciones del mercado;  tolerancia al riesgo por parte de los interesados; 
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•  clima político; canales de comunicación establecidos en la organización; 

•  bases de datos comerciales (por ej., datos para estimación estandarizada de 

costos; estudios de riesgos de la industria y bases de datos de riesgos), y 

•  sistemas de información para la dirección de proyectos (por ej., herramienta de 

software para definir cronogramas). 

1.2 Dirección de proyectos 
La dirección de proyectos es la aplicación de conocimientos, habilidades, herramientas y 

técnicas a las actividades de un proyecto, para satisfacer sus requisitos. Se logra mediante 

la aplicación e integración de los grupos de procesos que son: procesos de inicio, procesos 

de planificación, procesos de ejecución y procesos de seguimiento y control. 

 

Sus objetivos incluyen: 

 Identificar los requisitos 

 Establecer objetivos claros y realizables 

 Equilibrar las restricciones concurrentes del proyecto en aspectos de calidad, 

alcance, tiempo, presupuestos, recursos y riesgos.  

 Adaptar los planes, las especificaciones y el enfoque a las diversas inquietudes y 

expectativas de los diferentes interesados. 

 

Algunos de los Riesgos e incertidumbres que se presentan en los proyectos son los 

siguientes: 

 Incertidumbre en la programación 

 Incertidumbre en los costos 

 Incertidumbre en la tecnología 

 Otros riesgos de naturaleza política y organizacional. 

a) Gestión del portafolio 

El término portafolio se refiere a un conjunto de proyectos o programas y otros trabajos 

que se agrupan para facilitar la dirección eficaz de ese trabajo para cumplir con los 

objetivos estratégicos del negocio. La gestión del portafolio se centra en asegurar que los 

proyectos y programas se revisen a fin de establecer prioridades para la asignación de 

recursos, y en que la gestión del portafolio sea consistente con las estrategias de la 

organización y esté alineada con ella. 

 

Las organizaciones gestionan sus portafolios sobre la base de metas específicas. Una de 

las metas de la gestión del portafolio es maximizar el valor del portafolio evaluando con 
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cuidado los proyectos y programas candidatos a ser incluidos en el portafolio, y la 

exclusión oportuna de proyectos que no cumplan con los objetivos estratégicos del 

portafolio. Otras metas son equilibrar el portafolio entre inversiones incrementales y 

radicales, y usar los recursos de forma eficiente. Los gerentes o equipos de dirección, por 

lo general, asumen la responsabilidad de la gestión del portafolio para una organización.  

 

Dirección de programas 

Un programa se define como un grupo de proyectos relacionados administrados de forma 

coordinada para obtener beneficios y control, que no se obtendrían si se gestionaran en 

forma individual. Los programas pueden incluir elementos de trabajo relacionados que 

están fuera del alcance de los proyectos específicos del programa. Un proyecto puede o 

no formar parte de un programa, pero un programa incluye siempre proyectos. 

b) Proyectos y planificación estratégica 

A menudo, los proyectos se utilizan como el medio para cumplir con el plan estratégico de 

una organización. Por lo general, los proyectos se autorizan como resultado de una o más 

de las siguientes consideraciones estratégicas: 

 

•  Demanda del mercado, oportunidad estratégica/necesidad comercial, 

 

•  solicitud de un cliente (por ej., nueva subestación eléctrica para un parque industrial), 

 

•  adelantos tecnológicos (por ej., desarrollar una computadora portátil más pequeña), y 

 

•  requisitos legales (por ej., manipulación de un nuevo material tóxico). 

 

Con frecuencia, los proyectos se dividen en componentes o subproyectos más fáciles de 

gestionar, aunque los subproyectos individuales pueden ser considerados proyectos y 

dirigidos como tales.  
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 2. Ciclo de vida del proyecto y Organización 

2.1 Ciclo de vida del proyecto 
Los proyectos varían en tamaño y complejidad. Todos los proyectos, sin importar cuán 

pequeños o grandes, o cuán sencillos o complejos sean, pueden configurarse dentro de la 

siguiente estructura del ciclo de vida: inicio, organización y preparación, ejecución del 

trabajo y cierre. 

 
El ciclo de vida de un proyecto es el siguiente: 
 

 
 

Donde: 

 Inicio: formulación y selección del proyecto, se define el proyecto su alcance y su 

impacto.  

 Organización y preparación: planeación, se definen las tareas específicas que 

constituirán el proyecto y estiman los recursos 

 Ejecución: programación, control e implantación es el trabajo más intenso 

 Cierre: terminación, se entrega el proyecto al usuario. 

 

Los niveles de costos y dotación de personal son bajos al inicio del proyecto, alcanzan su 

punto máximo según se desarrolla el proyecto y decaen cuando se acerca al cierre. 
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2.2 Interesados o partes interesadas 
Los interesados son personas u organizaciones (por ejemplo, clientes, patrocinadores, la 

organización ejecutante o el público), que participan activamente en el proyecto, o cuyos 

intereses pueden verse afectados positiva o negativamente por la ejecución o terminación 

del proyecto. Los interesados también pueden ejercer influencia sobre el proyecto, los 

entregables y los miembros del equipo. El equipo de dirección del proyecto debe 

identificar tanto a los interesados internos como externos, con objeto de determinar los 

requisitos del proyecto y las expectativas de todas las partes involucradas. 

 

Entre los interesados se encuentran: clientes / usuarios, patrocinador, comité de revisión 

de proyectos, equipo de proyecto, gerentes funcionales, gerentes de operaciones, 

proveedores. 

 

Los interesados tienen diferentes niveles de responsabilidad y autoridad cuando 

participan en un proyecto y éstos pueden cambiar durante el ciclo de vida del mismo. 

Pueden ser Clientes/Usuarios, patrocinador, comité directivo, directores de proyectos, 

equipo de proyecto, gerentes funcionales, incluyendo a los proveedores. 

 

La influencia de los interesados, al igual que los riesgos y la incertidumbre son mayores al 

inicio del proyecto y disminuyen durante la vida del proyecto. El costo de los cambios y de 

corregir errores aumenta conforme el proyecto avanza al fin. 
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 2.3 Influencias de la organización en la dirección de 

proyectos 
Las culturas y estilos pueden tener una fuerte influencia en la capacidad del proyecto para 

alcanzar sus objetivos. Las culturas y estilos se conocen habitualmente como “normas 

culturales”. Las “normas” incluyen un conocimiento común sobre qué enfoque abordar 

para la realización del trabajo, qué medios se consideran aceptables para este fin y quién 

tiene influencia para facilitarlo. 

 

La estructura de la organización es un factor ambiental de la empresa que puede afectar la 

disponibilidad de recursos e influir en el modo de dirigir los proyectos. Las estructuras 

abarcan desde una estructura funcional hasta una estructura orientada a proyectos, con 

una variedad de estructuras matriciales entre ellas. 

 
INFLUENCIA DE LA ORGANIZACIÓN EN LOS PROYECTOS 

Estructura organizacional 
Funcional 

Matricial 
debil 

Matricial 
balanceado 

Matricial 
fuerte 

Proyectizado Característica del 
proyecto 

Autoridad del gerente de 
proyecto 

Poca o 
ninguna 

Limitada 
Coordinador 

Baja a 
moderada 

Baja a 
moderada 

Alta a casi 
total 

Disponibilidad de recursos 
Poca o 
ninguna 

Limitada 
Baja a 
moderada 

Baja a 
moderada 

Alta a casi 
total 

Quien controla el 
presupuesto del proyecto 

Gerente 
funcional 

Gerente 
funcional 

Mezclada 
Gerente de 
proyecto 

Gerente de 
proyecto 

Rol del gerente de 
proyecto 

Tiempo 
parcial 

Tiempo 
parcial 

Tiempo 
completo 

Tiempo 
completo 

Tiempo 
completo 

personal administrativo de 
apoyo al proyecto 

Tiempo 
parcial 

Tiempo 
parcial 

Tiempo parcial 
Tiempo 
completo 

Tiempo 
completo 

 
Organización matricial débil 
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  Organización matricial equilibrada 
 

 
                           
 
  Organización matricial fuerte 

 

2.4  Activos de los procesos de la organización  
                                   
Los activos de los procesos de la organización abarcan alguno o todos los activos relativos 

a procesos de alguna o todas las organizaciones participantes en el proyecto que pueden 

usarse para influir en el éxito del proyecto. Estos activos de procesos abarcan planes, 

políticas, procedimientos y lineamientos, ya sean formales o informales. Los activos de 

procesos también abarcan las bases de conocimiento de la organización, como las 

lecciones aprendidas y la información histórica. 
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3. Procesos de dirección de proyectos 
Los procesos de dirección de proyectos se agrupan en cinco categorías conocidas como 

Grupos de Procesos de la Dirección de Proyectos (o grupos de procesos): 

 

• Grupo del Proceso de Iniciación. Aquellos procesos realizados para definir un nuevo 

proyecto o una nueva fase de un proyecto ya existente, mediante la obtención de la 

autorización para comenzar dicho proyecto o fase. 

 

• Grupo del Proceso de Planificación. Aquellos procesos requeridos para establecer el 

alcance del proyecto, refinar los objetivos y definir el curso de acción necesario para 

alcanzar los objetivos para cuyo logro se emprendió el proyecto. 

 

• Grupo del Proceso de Ejecución. Aquellos procesos realizados para completar el trabajo 

definido en el plan para la dirección del proyecto a fin de cumplir con las especificaciones 

del mismo. 

 

• Grupo del Proceso de Seguimiento y Control. Aquellos procesos requeridos para dar 

seguimiento, analizar y regular el progreso y el desempeño del proyecto, para identificar 

áreas en las que el plan requiera cambios y para iniciar los cambios correspondientes. 

 

• Grupo del Proceso de Cierre. Aquellos procesos realizados para finalizar todas las 

actividades a través de todos los grupos de procesos, a fin de cerrar formalmente el 

proyecto o una fase del mismo. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Los grupos de procesos interactúan en una fase o proyecto. 

 

Proceso de 
iniciación 

Fase de 
arranque 

Proceso 
de 
planea-
ción 

Proceso 
de ejecu-
ción 

Fin del 
proyecto 

Proceso de 
cierre 

Procesos de seguimiento y control 



Administración efectiva de Proyectos gubernamentales   Dr. Primitivo Reyes A. /oct. 2011 

16 
 

Los Grupos de Procesos de dirección de proyectos están relacionados por los resultados 

que producen. La salida de un proceso, por lo general, se convierte en una entrada a otro 

proceso o es un producto entregable del proyecto. 

 

 
 

Entre  los documentos principales del proyecto se tienen: 
 

• Acta de Constitución o Contrato del Proyecto (Project Charter). Autoriza 

formalmente el proyecto que incluye el enunciado del Alcance del Proyecto. 

Establece el trabajo que debe realizarse y los productos entregables que deben 

producirse.  

• Los Planes de Gestión del Proyecto, establecen conforme se realizará el trabajo: 

plan de gestión del alcance, del cronograma, de costos, de calidad, de recursos 

humanos, de comunicaciones, de adquisiciones, etc. 

 

3.1 Grupo del Proceso de Iniciación 
 

El Grupo de Procesos de Iniciación se compone de procesos que facilitan la autorización 

formal para comenzar un nuevo proyecto o una fase del mismo. Antes de comenzar con 

las actividades del Grupo de Procesos de Iniciación, se documentan las necesidades o 

requisitos de negocio de la organización.  

 

Se establecen descripciones claras de los objetivos del proyecto, incluidas las razones por 

las cuales un proyecto específico es la mejor solución alternativa para satisfacer los 
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requisitos. La documentación de esta decisión también contiene una descripción básica 

del alcance del proyecto, de los productos entregables, de la duración del proyecto y un 

pronóstico de los recursos para el análisis de inversión de la organización. 

 

Además, durante el proceso de iniciación se refina la descripción del alcance inicial y los 

recursos que la organización está dispuesta a invertir. Si aún no hubiera sido designado, se 

elegirá al director del proyecto.  

 

Se documentarán las restricciones y supuestos iníciales. Esta información se refleja en el 

Acta de Constitución del Proyecto y, una vez aprobado, el proyecto queda oficialmente 

autorizado. Si bien el equipo de dirección del proyecto puede ayudar a redactar el Acta de 

Constitución del Proyecto, la aprobación y financiación se realizan fuera de los límites del 

proyecto. 

 

Un proyecto debe formularse cuidadosamente considerando todos los aspectos y riesgos. 

Para tomar la decisión de emprender o no un proyecto, debe realizarse un análisis 

cuidadoso y multidisciplinario considerando ventajas y riesgos, esto es la Evaluación del 

Proyecto. 

 

Estudio de prefactibilidad de un proyecto 

 

Se lleva a cabo con el objeto de obtener información sobre el proyecto a realizar sin hacer 

investigaciones de campo. Se toma en cuenta lo siguiente: 

 Antecedentes del Proyecto 

 Aspectos del mercado 

 Aspectos políticos y sociales 

 Aspectos Técnicos 

 Aspectos financieros 

 Evaluación del Proyecto 

 

Estudio de factibilidad de un proyecto 

 

En esta etapa se elabora el documento del Proyecto, que se integra por los análisis 

técnicos, económicos, financieros, de impacto ambiental y social, etc. Estableciendo los 

elementos cuantificables, considerando los siguientes aspectos: 

 Estudio del mercado 

 Estudio de disponibilidad de insumos 

 Localización y tamaño 
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 Ingeniería del proyecto 

 Inversión y financiamiento 

 Proyecciones financieras 

 Evaluación financiera 

 Impacto ambiental 

 Evaluación económica – social 

 
Los aspectos técnicos a evaluar son muy diversos, dependiendo del proyecto específico, 
algunos ejemplos incluyen: 
 

 Planos y diseño conceptual  

 Diseño detallado 

 Tecnologías a utilizar 

 Asistencia técnica externa requerida 

 Competencias técnicas necesarias del personal 

 Estudios de impacto ambiental 

 Estado de desarrollo, capacidad, costos, etc. 

 Localización de las instalaciones 

 Infraestructura e instalaciones requeridas 

 Mobiliario y equipos requeridos 

 Características geológicas y geotécnicas de la zona 
 

3.2 Grupo del Proceso de Planificación 
 

El Grupo del Proceso de Planificación está compuesto por aquellos procesos realizados 

para establecer el alcance total del esfuerzo, definir y refinar los objetivos, y desarrollar 

la línea de acción requerida para alcanzar dichos objetivos. Los procesos de planificación 

desarrollan el plan para la dirección del proyecto y los documentos del 

proyecto que se utilizarán para llevarlo a cabo. 

 

A medida que se obtenga nueva información sobre el proyecto, se identificarán o 

resolverán nuevas dependencias, requisitos, riesgos, oportunidades, supuestos y 

restricciones. Como consecuencia de la naturaleza multidimensional de la administración 

de proyectos se producen bucles de retroalimentación repetidos que se utilizan para 

nuevos análisis.  

 

El plan para la dirección del proyecto y los documentos del proyecto desarrollados 

como salidas del grupo de procesos de planificación, explorarán todos los aspectos del 

alcance, tiempo, costos, calidad, comunicación, riesgos y adquisiciones. 
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3.3 Grupo del Proceso de Ejecución 
 

El Grupo del Proceso de Ejecución está compuesto por aquellos procesos realizados para 

completar el trabajo definido en el plan para la dirección del proyecto a fin de cumplir con 

las especificaciones del mismo. Este grupo de proceso implica coordinar personas y 

recursos, así como integrar y realizar las actividades del proyecto de conformidad con el 

plan para la dirección del proyecto.  
 

Las variaciones en la ejecución normal harán necesaria cierta replanificación. Estas 

variaciones pueden incluir las duraciones de las actividades, la productividad y 

disponibilidad de los recursos, y los riesgos no anticipados. La mayor parte del 

presupuesto del proyecto se invertirá en los procesos del Grupo de Procesos de Ejecución. 

El Grupo de Procesos de Ejecución incluye los siguientes procesos de administración de 

proyectos: 

3.4 Grupo del Proceso de Seguimiento y Control 
 

El grupo del Proceso de Seguimiento y Control está compuesto por aquellos procesos 

requeridos para supervisar, analizar y regular el progreso y el desempeño del proyecto, 

para identificar áreas en las que el plan requiera cambios y para iniciar los cambios 

correspondientes.  

 

El beneficio clave de este grupo de procesos radica en que el  desempeño del proyecto se 

observa y se mide de manera sistemática y regular, a fin de identificar variaciones 

respecto del plan para la dirección del proyecto. El grupo de procesos de seguimiento y 

control también incluye: 

 

• Controlar cambios y recomendar acciones preventivas para anticipar posibles 

problemas, 

 

• dar seguimiento a las actividades del proyecto, comparándolas con el plan para la 

dirección del proyecto y la línea base desempeño de ejecución del proyecto 

 

• influir en los factores que podrían eludir el control integrado de cambios, de modo 

que únicamente se implementen cambios aprobados. 
 

Esta revisión puede dar lugar a actualizaciones recomendadas y aprobadas al plan para la 

dirección del proyecto. Por ejemplo, el incumplimiento de una fecha de finalización de 
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una actividad puede requerir ajustes al plan de personal vigente, la implementación de 

horas extra, o que se realicen concesiones entre los objetivos de presupuesto y 

cronograma. 

3.5 Grupo del Proceso de Cierre 
 

El Grupo del Proceso del Cierre está compuesto por aquellos procesos realizados para 

finalizar todas las actividades a través de todos los grupos de procesos de la dirección de 

proyectos, a fin de completar formalmente el proyecto, una fase del mismo u otras 

obligaciones contractuales. 

 

Este grupo de procesos, una vez completado, verifica que los procesos definidos se hayan 

completado dentro de todos los grupos de procesos a fin de cerrar el proyecto o una fase 

del mismo, según corresponda, y establece formalmente que el proyecto o fase del mismo 

ha finalizado. En el cierre del proyecto o fase, puede ocurrir lo siguiente: 

 

• Obtener la aceptación del cliente o del patrocinador, 

 

• realizar una revisión tras el cierre del proyecto o la finalización de una fase, 

 

• registrar los impactos de la adaptación a un proceso, 

 

• documentar las lecciones aprendidas, 

 

• aplicar actualizaciones apropiadas a los activos de los procesos de la organización, 

 

• archivar todos los documentos relevantes del proyecto en el sistema de información 

para la dirección de proyectos para ser utilizados como datos históricos y 

 

• cerrar las adquisiciones. 
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4. Dirección del proyecto 

4.1 Desarrollar el Plan para la Dirección del Proyecto 

Introducción 

Desarrollar el Plan para la Dirección del Proyecto es el proceso que consiste en 

documentar las acciones necesarias para definir, preparar, integrar y coordinar todos los 

planes subsidiarios. El plan para la dirección del proyecto define la manera en que el 

proyecto se ejecuta, se monitorea, se controla y se cierra. 

 

ENTRADAS: Project Charter o Contrato del proyecto, salidas de procesos de planeación, 

factores ambientales de la organización, activos de procesos de la organización. 

 

SALIDAS: Plan de dirección del proyecto. 

 

1. Desarrollar el Acta de Constitución del Proyecto—Es el proceso que consiste en 

desarrollar un documento que autoriza formalmente un proyecto o una fase y 

documentar los requisitos iniciales que satisfacen las necesidades y expectativas de 

los interesados. 

 

2. Desarrollar el Plan para la Dirección del Proyecto—Es el proceso que consiste en 

documentar las acciones necesarias para definir, preparar, integrar y coordinar todos 

los planes subsidiarios. 

 

Es la fuente primaria de información para determinar la manera en que se planificará, 

ejecutará, supervisará y controlará, y cerrará el proyecto.  

   

ENTRADAS: Project charter, salidas de procesos de planeación, factores ambientales de la 

organización, activos de procesos de la organización.  

   

SALIDAS: Plan de dirección del proyecto.  

 

3. Dirigir y Gestionar la Ejecución del Proyecto—Es el proceso que consiste en 

ejecutar el trabajo definido en el plan para la dirección del proyecto para cumplir con 

los objetivos del mismo. 
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4. Monitorear y Controlar el Trabajo del Proyecto—Es el proceso que consiste en 

monitorear, revisar y regular el avance a fin de cumplir con los objetivos de 

desempeño definidos en el plan para la dirección del proyecto. 

 

5. Realizar el Control Integrado de Cambios—Es el proceso que consiste en revisar 

todas las solicitudes de cambio, y en aprobar y gestionar los cambios en los entregables, 

en los activos de los procesos de la organización, en los documentos del proyecto y en el 

plan para la dirección del proyecto. 
 

ENTRADAS: plan de gestión del proyecto, información de desempeño del trabajo, 

solicitudes de cambios, factores ambientales de la organización y activos de procesos de la 

organización. 

 

SALIDAS: estatus y actualizaciones a solicitudes de cambios, actualización del plan de 

gestión del proyecto y actualización de documentos del proyecto. 

 

6. Cerrar Proyecto o Fase—Es el proceso que consiste en finalizar todas las actividades en 

todos los grupos de procesos de dirección de proyectos para completar formalmente el 

proyecto o una fase del mismo. 

a) Identificar a los Interesados 

Identificar a los Interesados es el proceso que consiste en identificar a todas las personas 

u organizaciones que reciben el impacto del proyecto, y en documentar información 

relevante relativa a sus intereses, participación e impacto en el éxito del proyecto. 
 

ENTRADAS: Project Charter, documentos de procuración, factores ambientales de la 

organización, activos de procesos de la organización. 

 

SALIDAS: Registro de partes interesadas, estrategia de gestión de partes interesadas. 

b) Desarrollar el Acta de Constitución del Proyecto (contrato) 

El desarrollo del Acta de constitución del proyecto, se relaciona principalmente con la 

autorización del proyecto. Es el proceso necesario para documentar las necesidades de 

negocio y el nuevo producto, servicio u otro resultado que se pretende obtener para 

satisfacer esos requisitos. Esta acta de constitución vincula el proyecto al trabajo continuo 

de la organización y autoriza el proyecto. Los proyectos son constituidos y autorizados 

fuera del proyecto por la organización o por un organismo de gestión de programas o del 

portafolio. 
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ENTRADAS 

 

 Enunciado del trabajo (Statement of work – SOW): Una descripción narrativa de los 

productos, servicios o resultados que deben suministrarse. 

 Caso de negocio: proporciona información desde una perspectiva organizacional 

para determinar si el proyecto es viable o no. Se puede incluir una justificación 

económica con análisis de costo beneficio para justificar el proyecto. 

 Contrato: Solo si el proyecto se hace para un cliente externo. 

 Factores ambientales de la organización: normas gubernamentales o industriales, 

infraestructura de la organización, condiciones externas (usuarios, etc.) 

 Activos de los procesos de la organización: procesos organizacionales, políticas, 

procedimientos, información histórica y lecciones aprendidas. 

 

SALIDAS 

 el propósito o la justificación del proyecto 

 los objetivos medibles del proyecto y los criterios de éxito relacionados 

 los requisitos de alto nivel 

 la descripción del proyecto de alto nivel 

 los riesgos de alto nivel 

 un resumen del cronograma de hitos 

 un resumen del presupuesto 

 los requisitos de aprobación del proyecto (qué constituye el éxito del proyecto, 

quién decide si el proyecto es exitoso y quién firma la aprobación del proyecto) 

 el director del proyecto asignado, su responsabilidad y su nivel de autoridad 

 el nombre y el nivel de autoridad del patrocinador o de quienes autorizan el acta 

de constitución del proyecto. 

 

Análisis económico para obtener la aprobación del proyecto:  

ENTRADAS 
1. Enunciado del trabajo (SOW) 
2. Caso de negocio 
3. Contrato 
4. Factores ambientales de la 
organización 
5. Activos de los procesos 
organizacionales 

SALIDAS 
1. Acta de constitución del 
proyecto (Project charter) 

HERRAMIENTA 
1. Juicio de 
expertos 
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 Identificar los beneficios del proyecto: monto, tiempo, duración  

 Identificar los factores de costo del proyecto (personal, recursos) así como los 

gastos del periodo 

 Calcular la ganancia neta  por periodo (usuarios atendidos por unidad invertida) 

 Calcular los índices financieros (TIR, VPN, etc.) 

 Determinar si el proyecto se implementará (antes de iniciarlo) o si fue benéfico 

(después de completarlo) 

 Si no da beneficios, pero de todas formas se debe implementar, justificarlo 

(ambiente, seguridad)  

 

Valor presente de una cantidad futura 

La suma que es necesario invertir ahora para acumular una determinada cantidad en el 

futuro con un tipo de interés específico. 

 

Fórmula: P = 
nr

F

)1( 
 

 

Ejemplo: Se desea hacer una inversión con el propósito de que tenga un valor de $10,000 

dentro de un año. Si el tipo de interés aplicado es del 12% y P representa la suma invertida 

hoy entonces: 

 

P=
1)12.01(

000,10


= $8,929 

 

Flujo de efectivo: Cantidad de efectivo que fluirá hacia dentro y hacia fuera de la 

organización por causa de un determinado proyecto, e incluye los ingresos, los costos y los 

cambios en activos y pasivos. 

- Considerar únicamente las cantidades de los flujos de efectivo que se modificarán 

si el proyecto se realiza. A estas cantidades se les conoce también como flujos de 

efectivos graduales: son la diferencia entre los flujos de efectivo en presencia del 

proyecto y en ausencia de él. 

- Convertir los flujos de efectivo en cantidades netas (después de impuestos) antes 

de aplicarles el método del valor presente neto, el método basado en amortización 

o el método de la tasa interna de rendimiento. En este paso, los impuestos y la 

depreciación se incorporan a los cálculos. 

 

Depreciación: descuento que se concede por el consumo de capital. (actúa como un 

escudo contra los impuestos).   
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Fórmula de la Depreciación en línea recta:  

 

D= 
n

SI 
 

 

Donde: D= depreciación anual 

  I=   total de la inversión 

  S= valor de rescate 

  n= número de años de la vida del proyecto  

 

Análisis de flujos de efectivos 

 

Se está estudiando la posibilidad de agregar una barra de ensaladas a un restaurante local. 

La inversión necesaria para remodelar el área de comedor y agregar la barra de ensaladas 

asciende a $16,000. 

 

- El precio y costo variable por ensalada son de $3.50 y $2.00, respectivamente 

 

- La demanda anual tendrá que ser del orden de 11,000 ensaladas. 

 
- Los costos fijos, además de la depreciación, serán de $8,000 y en ellos están 

incluidos los correspondientes a la energía necesaria para el funcionamiento de la 

unidad frigorífica y los salarios de un empleado adicional, de tiempo parcial que se 

encargará de abastecer la barra de ensaladas en las horas del movimiento más 

intenso. 

 
- Para propósitos de depreciación, los activos corresponden a la clase de 5 años  y 

no tiene ningún valor de rescate. 

 
- La tasa tributaria es de 40%. 

 
- La gerencia desea obtener un rédito de 14% después de impuestos durante toda la 

vida de este proyecto. 
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Solución 

Inversión $16,000 

Tipo de interés 0.14 

 

Flujo de efectivo 

  2004 2005 2006 2007 2008 2009 2010 

Demanda anual (ensaladas)   11,000 11,000 11,000 11,000 11,000   

Ingresos   $38,500 $38,500 $38,500 $38,500 $38,500   

costos variables   $22,000 $22,000 $22,000 $22,000 $22,000   

costos fijos   $8,000 $8,000 $8,000 $8,000 $8,000   

Depreciación (D)   $3,200 $5,120 $3,072 $1,843 $1,843 $922 

ingresos antes de impuestos   $5,300 $3,380 $5,428 $6,657 $6,657 -$922 

impuestos (40%)   $2,120 $1,352 $2,171 $2,663 $2,663 -$369 

Ingreso neto de 
operación(NOI)   $3,180 $2,028 $3,257 $3,994 $3,994 -$553 

Flujo de efectivo total (NOI+D)   $6,380 $7,148 $6,329 $5,837 $5,837 $369 

 

VALOR PRESENTE NETO (VPN) 

 

Se usa para evaluar una inversión mediante el cálculo de los valores presentes del total de 

todos los flujos de efectivo después de impuestos y luego retando la cantidad de la 

inversión original de ese total. La diferencia es el valor presente neto del proyecto.  

 

- Si el valor presente neto es positivo para la tasa de descuento aplicada, la 

inversión gana una tasa de rendimiento más alta que la tasa de descuento. VPN>0 

 

- Si el valor presente neto es negativo, la inversión gana un rendimiento más bajo 

que la tasa de descuento. VPN < 0 

 

La tasa de descuento que representa el rendimiento sobre la inversión más bajo deseado 

se concibe como un obstáculo que dicha inversión tendrá que ser capaz de superar, por lo 

cual se le conoce a menudo como la tasa de obstáculos. 

 

MÉTODO DE LA TASA INTERNA DE RENDIMIENTO (TIR) 

 

Tasa de descuento con la cual el valor presente neto de un proyecto se vuelve cero. Se 

considera interna porque depende únicamente de los flujos de efectivo de la propia 

inversión, no de las tasas que se ofrezcan en otros lugares. 
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Con este método, un proyecto sólo será aceptable si la tasa interna de rendimiento es 

mayor que la tasa de obstáculos. 

 

Ejemplo: Tomando el ejemplo de la barra de ensaladas 

Puesto que la gerencia desea obtener un rendimiento de 14% sobre su inversión. El valor 

presente del flujo de efectivo total de cada año y el VPN del proyecto son los siguientes: 

 

2005: $6,380 (0.8772)= $5,597 

2006:  $7,148 (0.7695)= $5,500 

2007: $6,329 (0.6750)= $4,272 

2008: $5,837 (0.5921)= $3,456 

2009: $5,837 (0.5194)= $3,032 

2010: $   369 (0.4556)= $   168 

 

VPN = ($5,597+$5,500+$4,272+$3,456+$3,032+$168)-$16,000 = $6,024 

 

Ya que el VPN es positivo, la recomendación sería que se aprobara el proyecto. 

 

Para calcular la tasa interna de retorno, comencemos con la tasa de descuento de 14%, la 

cual produjo un VPN positivo. Al introducir incrementos de 4% en cada paso, llegamos a 

un VPN negativo con una tasa de descuento de 30%, si retrocedemos a 28% el VPN es de 

322. Por consiguiente la TIR es de 29% aproximadamente. 

 

TREMA=  Tasa de rendimiento mínima aceptable 

 

EFECTO DEL IMPUESTO Y LA DEPRECIACIÓN 

 

Sólo los flujos de efectivo reales son relevantes para las decisiones sobre los proyectos. 

Los beneficios antes de la depreciación e impuestos no representan los beneficios reales 

para la institución. Por tanto los beneficios deben ajustarse en función de la depreciación 

e impuestos. 

 

La depreciación puede ser considerada como un gasto que reduce las utilidades brutas 

para efectos de impuestos. 

 

Asumiendo que una máquina cueste $10,000 con una vida útil de 5 años y que se espera 

que produzca $4,000 cada año, se tiene: 
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Depreciación por año = (costo inicial – valor de rescate) / vida útil 

Depreciación = (10,000 – 0) / 5 = 2,000 

A. Utilidad bruta     $4,000 

B. Gasto por depreciación    $2,000 

C. Utilidad antes de impuestos (A – B)   $2,000 

D. Impuestos (40% de C)    $800 

 

E. Flujo de efectivo   (A – D)  $3,200 

 

Si la TREMA para la institución es del 10%, el valor presente neto de la inversión es 

$3,200/P/A,10%,5)  - 10,000 = 3,200*(3,791) – 10,000 = $2,131 lo que indica que el 

proyecto es viable. 

 

Ejercicio: 
Asumiendo un interés del 15% y costo del equipo de $15,000 

 
 
 
 
 
 
 
 

VNA = Valor presente neto en Excel   

Fx Financieras = VNA(0.15, rango no incluye inversión)                 VPN = VNA  - Inversión 

 

Conclusión: Si VPN es positivo si conviene la inversión 

 

TIR = Tasa interna de rendimiento = TIR( rango incluye invesión negativa)= 24%  

 
Conclusión: Si el TIR es mayor que la TREMA de la institución, el proyecto es viable 
 

 

Evaluar áreas potenciales de riesgo del proyecto como: cambios en la tecnología, falta de 

materiales, reglamentaciones de seguridad e higiene, Reglamentaciones ambientales, 

riesgos asegurables (propiedad, pérdidas, responsabilidad legal). 

Interés 0.15 

Inversión -15,000 

Año 1 5,000 

Año 2 5,000 

Año 3 5,000 

Año 4 5,000 

Año 5 9,000 
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EJERCICIOS:

2.1 Suponga que un equipo cuesta $20,000 con una vida útil de 5 años, al final 

de los cuales se rescata en $4,000. Si la tasa mínima de retorno o tasa de 

interés es de 15% ¿Cuál es el valor presente?

R = 4,000

1 2 3 4 5

P=20,000

 P = - 20,000 + 4,000 (P/F, 15%, 5) P/F = 1 / (1 + i)
n

P = -20,000 + 4,000*0.4865081 Si n = 15%

P =   -18,054 n = 5

P/F = 0.4865081

2.2 Considerar las siguientes dos alterantivas diferentes, y recomiende cual debe ser implementada:

Máquina A Máquina B

Costo inicial $20,000 $30,000  

Vida en años 5 10

Valor de rescate $4,000 0

Beneficios anuales $10,000 $14,000

Gastos anuales de oper. $4,400 $8,600

Tasa de rendimiento mínima atractiva = 15%

Asumir 10 años 

Solución:

Ingresos Gastos Flujos Ingresos Gastos Flujos

Periodo  Máquina A Máquina A Periodo Máquina A Máquina A

1 10000 4400 5600 1 14000 8600 5400

2 10000 4400 5600 2 14000 8600 5400

3 10000 4400 5600 3 14000 8600 5400

4 10000 4400 5600 4 14000 8600 5400

5 14,000 4400 9600 5 14000 8600 5400

6 14000 8600 5400

VP $20,760.78 7 14000 8600 5400

8 14000 8600 5400

VPN = VP - Costo Maq. 1 = $760.78 9 14000 8600 5400

10 14000 8600 5400

Es mejora la máquina 1 VP = $27,101.35

VPN = VP - Costo Maq. 2 = -$2,898.65
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Máquina A Máquina B

Inversión -20000 Inversión -30000

Periodo 1 5600 Periodo 1 5400

Periodo 2 5600 Periodo 2 5400

Periodo 3 5600 Periodo 3 5400

Periodo 4 5600 Periodo 4 5400

Incluye resc. Periodo 5 9600 Periodo 5 5400

de $4,000 TIR 16% Periodo 6 5400

Periodo 7 5400

Periodo 8 5400

Periodo 9 5401

Periodo 10 5400

TIR 12%

Prob. 2.7 Se tiene dos equipos de medición para cierto laboratorio industrial.

MA MB

Costo inicial $15,000 $15,000  

Vida en años 3 5

Valor de rescate $0 0

Gastos anuales de oper. $4,400 $8,600

Tasa de rendimiento mínima atractiva = 20%

Ingresos Gastos Flujo Ingresos Gastos  

Equipo A Equipo A Equipo B Equipo B Flujo

Periodo 1 0 4400 -4400 Periodo 1 0 8600 -8600

Periodo 2 0 4400 -4400 Periodo 2 0 8600 -8600

Periodo 3 0 4400 -4400 Periodo 3 0 8600 -8600

Periodo 4 0 8600 -8600

Periodo 5 0 8600 -8600

-$9,268.52

-$25,719.26

VPN = -$24,268.52 VPN = -$40,719.26

Cuesta menos

Prob. 2.12 Una empresa invierte $15,000 en un proyecto que parece tener un potencial excelente. 

Desafortunadamente una disputa laboral en el año 3 resulta en costos que exceden a los

beneficios en $8,000. El flujo de efectivo es como sigue:

Año 0 1 2 3 4 5 6

Flujo -15000 10000 6000 -8000 4000 4000 4000

Determinar la tasa de retorno para el proyecto

Asumir una tasa de interés del 12% para inversiones externas

TIR = 12% El proyecto da lo mismo que las inversiones externas
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Prob. 2.14 Una empresa considera cuatro inversiones diferentes como parte de su mejorar en producción

A B C D

Costo de instalación 1,000 800 600 500

Beneficios anuales uniformes 122 120 97 122

Vida útil en años 8 8 8 8

Valor de rescate 750 500 500 0

¿Cuál alternativa debe ser seleccionada?, si la tasa de interés mínima atractiva es de 8%

 

A B C D

Periodo Ingresos Ingresos Ingresos Ingresos

1 122 120 97 122

2 122 120 97 122

3 122 120 97 122

4 122 120 97 122

5 122 120 97 122

6 122 120 97 122

7 122 120 97 122

8 872 620 597 122

VP = $1,106.29 $959.73 $827.56 $701.09

VPN = $106.29 $159.73 $227.56 $201.09

Esta es mejor

TIRS

A B C D

Periodo/ Inv. -1,000 -800 -600 -500

1 122 120 97 122

2 122 120 97 122

3 122 120 97 122

4 122 120 97 122

5 122 120 97 122

6 122 120 97 122

7 122 120 97 122

8 872 620 597 122

TIR 10% 12% 15% 18%

Ejercicio considerando depreciación e impuestos:

Asumiendo que una máquina cueste $10,000 con una vida útil de 5 años y que se espera 

que produzca $4,000 cada año, se tiene:

Depreciación por año = (costo inicial – valor de rescate) / vida útil

Depreciación = (10,000 – 0) / 5 = 2,000

A. Utilidad bruta $4,000

B. Gasto por depreciación $2,000

C. Utilidad antes de impuestos (A – B) $2,000

D. Impuestos (40% de C) $800

E. Flujo de efectivo (A – D) $3,200
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Periodo 1 3200

Periodo 2 3200

Periodo 3 3200

Periodo 4 3200

Periodo 5 3200

VP  = $12,130.52

VPN = $2,130.52

Problema de reemplazo.

Durante 5 años se ha usado una máquina etiquetadora, fue comprada en $4,000 y se ha 

ido depreciando a 10 años sin valor de rescate al final. La máquina puede ser vendida en

$2,000.00

La empresa puede adquirir una nueva máquina por $6,000 con una vida útil de 5 años y reduce 

costos de personal por $1,200 al año. La vieja máquina requiere un mantenimiento mayor

en los próximos meses. El costo de la reparación es de $300.

Si se compra la nueva máquina se depreciará a 5 años con un valor de rescate de $500.

La empresa imvertirá en la alternativa que pase del 12% que es el costo del capital.

La tasa de impuestos es de 40%.

¿Debe comprarse la máquina nueva?

Solución.

Paso 1. Determinar el costo de la inversión

Costo de la máquina nueva $6,000

Menos: Venta de máquina vieja $2,000

Menos: Costo de mantto. Mayor $300

Costo efectivo de la inversión $3,700

Paso 2. Beneficios anuales

Reducción de personal $1,200

Paso 3. Diferencial de depreciación

      MV: Depreciación anual de la máquina vieja $400   =(4,000 - 0) / 10

      MN: Depreciación anual de la máquina nueva $1,100    =(6,000 - 500) / 5

Diferencia en depreciación = MN - MV = 700    =(1,100 - 400)

Paso 4. Determinar el incremento anual en utilidades en la empresa

Ahorros de costos $1,200

Impuestos 40% $480

Agregar ventaja en incremento en depreciación

  =0.4*700 $280

Deducción neta -$200

Incremento anual en utilidades $1,000
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Formato de Contrato del proyecto 

1. Nombre del proyecto 

2. Alineación del proyecto con estrategias y objetivos (caso negocio) 

 

 

 3. Alcance del proyecto 

Incluye: 

 

No incluye: 

 

 4. Benchmarking 

 

5. Meta medible con sus Métricas y sigmas del proceso 

Desempeño actual, identificación de la línea base: 

 

Métricas del proyecto específicas: 

 

 

 

 6. Fecha inicial y final  

7. Metas intermedias y programa de trabajo: 

Ejemplo: 

Metas intermedias Fecha de revisión 

  

  

  

  

Paso 5. Encontrar el valor presente de los flujos de efectivo

Periodo 1 $1,000

Periodo 2 $1,000

Periodo 3 $1,000

Periodo 4 $1,000

Periodo 5 $1,500   Incluye valor de rescate al año 5 de $500

VP = $3,888.49

Paso 6. valor presente neto = Valor presente de los beneficios - Costo de la inversión

VPN = 3888.49 - 3700 = 189.00
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8. Justificación financiera del proyecto (ROI,TIR,NPV) 

Vida útil del proyecto: 

 

Beneficios tangibles estimados por año: 

 

 

Tasa Interna de rendimiento: 

 

 

Beneficios intangibles del proyecto: 

 

9. Análisis de riesgos del proyecto: 

 

Riesgos de no hacer el proyecto: 

 

 

Supuestos para lograrlo: 

 

 

Obstáculos potenciales: 

 

Áreas afectadas, comunicación y responsabilidades: 

 

Áreas 
afectadas: 

Responsable: Comunicación: Responsabilidades: 

    

    

 

10. Equipo de trabajo:  

 

Promotor:                                                   Asesor: 

Asesor:                                                       Dueño del proceso: 

Dueño del proceso:                                    Líder del proyecto: 

Miembros: 

Miembros del equipo: 

Personal de apoyo: 
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4.2 Gestión del alcance del proyecto 
 
La Gestión del Alcance del Proyecto incluye los procesos necesarios para garantizar que el 

proyecto incluya todo el trabajo requerido para completarlo con éxito. El objetivo 

principal de la Gestión del Alcance del Proyecto es definir y controlar qué se incluye y 

qué no se incluye en el proyecto.  Se incluye: 

 

ENTRADAS: Project charter, documentación de requisitos, activos de procesos de la 

organización. 

 

SALIDAS: estatutos del alcance del proyecto, actualizaciones de la documentación del 
proyecto.  
 

1. Recopilar Requisitos—Es el proceso que consiste en definir y documentar las 

necesidades de los interesados a fin de cumplir con los objetivos del proyecto. 

 

ENTRADAS: Project Charter, registro de las partes interesadas. 

 

SALIDAS: documentación de requisitos, plan de gestión de requisitos, matriz de rastreo de 
requisitos.  
 

2. Definir el Alcance—Es el proceso que consiste en desarrollar una descripción 

detallada del proyecto y del producto. 

 

3. Crear la EDT (WBS – Estructura de desglose del trabajo) Es el proceso que consiste en 

subdividir los entregables y el trabajo del proyecto en componentes más pequeños y más 

fáciles de manejar. 

 

ENTRADAS: Project charter, documentación de requisitos, activos de procesos de la 

organización. 

 

SALIDAS: EDT, diccionario de EDT, línea base del alcance, actualizaciones de la 
documentación del proyecto.  
 

4. Verificar el Alcance—Es el proceso que consiste en formalizar la aceptación de los 

entregables del proyecto que se han completado. 

 

ENTRADAS: plan de gestión del proyecto, requisitos de la documentación, matriz de 

rastreabilidad de requisitos, entregables validados. 
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SALIDAS: entregables aceptados, solicitudes de cambios y actualización de documentos 

del proyecto. 

 

5. Controlar el Alcance—Es el proceso que consiste en monitorear el estado del alcance 

del proyecto y del producto, y en gestionar cambios a la línea base del alcance. 

 

ENTRADAS: plan de gestión del proyecto, información de desempeño del trabajo, 

requisitos de la documentación, matriz de rastreabilidad de requisitos y activos de 

procesos de la organización. 

 

SALIDAS: mediciones de desempeño del trabajo, actualización de activos de procesos de la 

organización, solicitudes de cambio, actualizaciones del plan de gestión del proyecto y 

actualización de la documentación del proyecto. 

 

Estos procesos interactúan entre sí y con los procesos de las otras áreas de conocimiento. 

Cada proceso puede implicar el esfuerzo de una o más personas, dependiendo de las 

necesidades del proyecto. Cada proceso se ejecuta por lo menos una vez en cada proyecto 

y en una o más fases del proyecto, en caso de que el mismo esté dividido en fases.  

 

En el contexto del proyecto, el término alcance puede referirse a: 

• Alcance del producto. Las características y funciones que definen un producto, servicio 

o resultado. 

• Alcance del proyecto. El trabajo que debe realizarse para entregar un producto, servicio 

o resultado con las características y funciones especificadas. 

 

4.3 Gestión del Tiempo del Proyecto 
La Gestión del Tiempo del Proyecto incluye los procesos requeridos para administrar la 

finalización del proyecto a tiempo:: 

 

1. Definir las Actividades—Es el proceso que consiste en identificar las acciones 

Específicas a ser realizadas para elaborar los entregables del proyecto. 

 

ENTRADAS: Línea base del alcance, factores ambientales de la organización, activos de 

procesos de la organización. 
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SALIDAS: Lista de actividades, atributos de las actividades, lista de puntos de control o 
metas intermedias (milestones).  
 

2. Secuenciar las Actividades—Es el proceso que consiste en identificar y documentar 

las interrelaciones entre las actividades del proyecto. 

 

3. Estimar los Recursos de las Actividades—Es el proceso que consiste en estimar el 

tipo y las cantidades de materiales, personas, equipos o suministros requeridos para 

ejecutar cada actividad. 

 

ENTRADAS: Lista de actividades, atributos de las actividades, calendarios de recursos, 

activos de procesos de la organización, factores ambientales de la organización. 

 

SALIDAS: requisitos de recursos para las actividades, detalle de la estructura de recursos 

(resource breakdown structure) y actualización de la documentación del proyecto. 

 

4. Estimar la Duración de las Actividades—Es el proceso que consiste en establecer 

aproximadamente la cantidad de períodos de trabajo necesarios para finalizar cada 

actividad con los recursos estimados. 

ENTRADAS: Lista de actividades, atributos de las actividades, lista de puntos de control o 

metas intermedias (milestones), estatuto del alcance del proyecto, activos de procesos de 

la organización. 

 

SALIDAS: Diagrama de red de actividades de proyecto,  actualizaciones de la 
documentación del proyecto. 
 

5. Desarrollar el Cronograma—Es el proceso que consiste en analizar la secuencia de 

las actividades, su duración, los requisitos de recursos y las restricciones del 

cronograma para crear el cronograma del proyecto. 

 

ENTRADAS: Lista de actividades, atributos de las actividades, diagrama de red de 

actividades, requisitos de recursos de actividades, calendario de recursos, estimado de 

duración de actividades, estatuto del alcance del proyecto, activos de procesos de la 

organización, factores ambientales de la organización. 

 

SALIDAS: programa del proyecto, línea base del programa, datos del programa , 

actualizaciones de la documentación del proyecto. 

 



Administración efectiva de Proyectos gubernamentales   Dr. Primitivo Reyes A. /oct. 2011 

39 
 

6. Controlar el Cronograma—Es el proceso por el que se da seguimiento al estado del 

proyecto para actualizar el avance del mismo y gestionar cambios a la línea base del 

cronograma. 

 

ENTRADAS: plan de gestión del proyecto, programa del proyecto, información de 

desempeño del trabajo y activos de procesos de la organización. 

 

SALIDAS: mediciones de desempeño del trabajo, actualización de activos de procesos de la 

organización, solicitudes de cambio, actualizaciones del plan de gestión del proyecto y 

actualización de la documentación del proyecto. 

a) Dar Seguimiento y Controlar el Trabajo del Proyecto 

Dar Seguimiento y Controlar el Trabajo del Proyecto es el proceso que consiste en revisar, 

Analizar y regular el avance a fin de cumplir con los objetivos de desempeño definidos en 

el plan para la dirección del proyecto. Dar Seguimiento implica realizar informes de 

estado, mediciones del avance y proyecciones. Los informes de desempeño suministran 

información sobre el desempeño del proyecto en lo relativo al alcance, cronograma, 

costos, recursos, calidad y riesgos, que puede utilizarse como entrada para otros procesos. 

 

ENTRADAS: plan de gestión del proyecto, reportes de desempeño, factores ambientales 

de la organización y activos de procesos de la organización. 

 

SALIDAS: solicitudes de cambios, actualización del plan de gestión del proyecto y 

actualización de documentos del proyecto. 

 

El establecimiento de la secuencia de las actividades implica identificar y documentar las 

relaciones lógicas entre las actividades del cronograma. Las actividades del cronograma 

pueden estar ordenadas de forma lógica con relaciones de precedencia adecuadas, así 

como también adelantos y retrasos, para respaldar el desarrollo posterior de un 

cronograma del proyecto realista y factible. El establecimiento de la secuencia puede 

realizarse utilizando el software de gestión de proyectos MS Project o técnicas manuales.  
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Método de Diagramación con Flechas  

b) Desarrollo del Cronograma: Herramientas y Técnicas  

La programación del proyecto, a diferencia de la planeación del mismo, es más específica. 

La programación establece tiempos para la realización de las diversas fases del proyecto. 

En la programación el administrador considera las muchas actividades de un proyecto 

global y las tareas que han de llevarse a cabo, relacionando éstas entre sí coherentemente 

y conforme al calendario. 

 

El “Statement Of Work” o Estructura del Proyecto (EDT) es un plan detallado que expande 

el proyecto en una lista de actividades necesarias para terminar el proyecto, elaborado 

por el líder de proyecto. Cada proyecto se divide en actividades más pequeñas y después 

en elementos hasta que sea identificable la responsabilidad de su realización 

 

Cada actividad es programada de acuerdo a su interrelación con otras. El programa 

balancea las restricciones de tiempo, recursos, restricciones y costo. Los retardos en 

tiempo requieren costos y recursos adicionales para mantener las fechas de terminación.  

 

Después de la lista detallada de actividades, se usan técnicas como PERT, Gráficas de 

Gantt y CPM. 

 

Las reglas para las técnicas de planeación de redes son: 

 Antes de que inicie una actividad, todas sus precedentes deben haber sido 

terminadas 
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 Las flechas sólo indican precedencia, su tamaño no indica nada 

 Dos eventos cualesquiera sólo pueden ser conectados por una actividad 

 Los números de los eventos son únicos 

 La red debe iniciar y terminar en un solo evento. 

c) Gráfica de Gantt 

Herramienta popular en la programación de la producción y de proyectos. Cada actividad 

está inscrita sobre el eje vertical. El eje horizontal es el tiempo y la duración anticipada de 

cada actividad, así como la duración real. 

 

Muestra actividades o eventos en función del tiempo, cada barra horizontal inicia en la 

fecha de inicio de la actividad y finaliza en su fecha de terminación. 

 

La gráfica indica también el tiempo más temprano (o próximo) posible de inicio de cada 

actividad. Conforme cada actividad (o parte de ella) es terminada, se sombrea la barra 

apropiada. 

 

Se utiliza principalmente como dispositivo de registro para seguir el avance en el tiempo 

de las subtareas de un proyecto. La frase “dentro de programa” significa que ha sido 

terminada en un tiempo no posterior al tiempo más próximo de terminación 

 

Ventajas: fáciles de entender, una barra por actividad, es fácil de cambiar, usa pocos 

datos, muestra los avances. 

 

Desventaja: no revela: cuales actividades son predecesores inmediatos de otras 

actividades; la Interdependencia de actividades; el efecto de actividades retardadas; 

detalles de la actividad. 

 

Ejemplo de Gantt utilizando el paquete Microsoft Project 
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Ejercicios: 

1. Elaborar la lista de actividades del proyecto seleccionado en equipo, definir la duración 

de cada actividad y su predecesor inmediato. Presentar a los demás miembros del 

grupo. 

 

2. Se tiene el siguiente proyecto. 

ACTIVIDAD PREDECESOR INMEDIATO DURACIÓN (SEMANAS) 

A - 5 

B - 3 

C A 8 

D A,B 7 

E - 7 

F C,E,D 4 

G F 5 

 

Sacar la gráfica Gantt de este proyecto y sacar la gráfica Gantt del ejercicio 1. Presentar a 

los demás miembros del grupo. 

 

3. Suponiendo que el proyecto del ejercicio 1 ya está corriendo actualmente, presentar la 

gráfica Gantt utilizando la simbología del mismo para especificar cuál es el avance de 

cada actividad. (Presentar al grupo). 

d) Diagrama de Red (PERT) 

Tiene los siguientes requerimientos: 

 Evento es cada punto de inicio o terminación de actividades, también se llama 

nodo 

 Los eventos se conectan con flechas con un número que indica la duración de la 

actividad 

 Cada actividad está representada por una flecha llamada rama o arco. 

 El principio y fin de cada actividad están indicados por un círculo llamado nodo 

 El término evento es utilizado en conexión con los nodos. 

 Todas las actividades individuales deben ser incluidas 

 Los eventos y actividades deben estar en secuencia en la red para permitir la 

determinación de la ruta crítica 

 Se deben hacer estimados de duración para cada actividad en la red, estimados 

como: optimista, normal, pesimista 



Administración efectiva de Proyectos gubernamentales   Dr. Primitivo Reyes A. /oct. 2011 

43 
 

 Se calculan la ruta crítica y tiempos de holgura para el proyecto. La ruta crítica es la 

que tiene la mayor duración.  

 Slack Time=Tiempos inicio tardío - temprano 

 El tiempo estimado entre eventos es: 

 

 

 

 

 

 

 

 

 

Ventajas: 

 Se pueden identificar relaciones entre tareas y áreas problemáticas 

 Se puede determinar la probabilidad de alcanzar las fechas establecidas y en 

todo caso desarrollas planes alternos 

 Se puede evaluar el efecto de cambios en el proyecto 

 Representa una gran cantidad de información para tomar decisiones 

 Se puede usar en proyectos únicos no repetitivos 

 

Desventajas 

 Su complejidad incrementa los problemas de implementación 

 Se requieren más datos como entradas a la red 

e) Estimación de la duración de actividades del proyecto 

 Un proyecto está compuesto por una serie de tareas. Cada tarea es desempeñada por 

una unidad organizacional. La mayoría de tareas puede seccionarse en actividades. Cada 

actividad está caracterizada por sus especificaciones tecnológicas, dibujos, lista de 

materiales requeridos, requerimientos de control de calidad, etc. El  proceso tecnológico 

seleccionado para cada actividad afecta los recursos requeridos, los materiales 

necesitados y el tiempo de las mismas. 

 

El proceso de dividir una tarea dentro de actividades, y actividades dentro de 

subactividades, pueden ser desempeñadas cuidadosamente para tener un balance entre 

la duración y el tamaño. 

4
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Podemos decir que “seleccionar sitio de oficinas” se denomina como actividad A, cuando 

termina esta actividad, ocurre el evento “sitio de oficinas seleccionado”. 

 
Ruta  
Secuencia de actividades conectadas, que nos llevan del nodo de inicio al nodo de 

terminación. Para dar por concluido el proyecto deben estar terminadas las actividades de 

todas las rutas 

 
Ruta critica 
 La ruta más larga desde el comienzo hasta el final. Esta ruta llamada la ruta crítica 

determinará la duración total del proyecto, porque ninguna otra ruta será más larga. 

 

 Si las actividades en la ruta más larga se atrasan, entonces, debido a que estas actividades 

deben ser terminadas, todo el proyecto completo estará retrasado. 

 
Actividades críticas 

 Actividades de la ruta crítica. 

 

Lista de actividades 

1. El primer paso en el proceso es definir las actividades del proyecto y establecer las 

relaciones de precedencia apropiadas (para llevar a cabo este paso hay que 

involucrar a varias personas, de forma que no se pasen por alto actividades 

importantes, TRABAJO DE EQUIPO NO INDIVIDUAL). 

 

Ejercicio: 

ACTIVIDAD DESCRIPCIÓN PREDECESOR INMEDIATO TIEMPO 

A Seleccionar sitio de oficinas - 3 

B Crear plan organizacional y financiero - 5 

C Determinar requerimientos de personal B 3 

D Diseñar la instalación A,C 4 

E Construir el interior D 8 

F Seleccionar al personal que va a transferir C 2 

G Contratar nuevos empleados F 4 

H Trasladar registros, personal clave F 2 

I Hacer arreglos financieros con Bancos B 5 

J Capacitar al nuevo personal H,E,G 3 
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EJEMPLO: Cambio de oficinas

Tiempo de la 

Actividad Descripción Predecesores Actividad en semanas

A Seleccionar sitio nuevo - 3

B Crear plan org. Y financiero - 5

C Det. Req. De personal B 3

D Diseñar instalación A,C 4

E Construir el interior D 8

F Sel. personal a transferir C 2

G Contratar nuevos empl. F 4

H Trasladar registros, pers. F 2

I Arreglos con bancos B 5

J Capacitar nuevo personal H, E, G 3

RUTA CRÍTICA - La secuencia de actividades más larga que nos llevan del nodo de inicio al nodo de terminación

ACTIVIDADES CRÍTICAS - Actividades dentro de la ruta crítica.

 D = 4

E = 8

A = 3

F = 2      H = 2 J = 3

G = 2

    B = 5   C = 3

I = 5

ANALISIS DE SENSIBILIDAD - Permite ver el tiempo de inicio más próximo (TIP) y el tiempo de

terminación más próximo de cada actividad (TTP) sin afectar la solución presente.

t = Tiempo esperado de duración de la actividad

1 4

3

6

52

7

8

9
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CALCULOS DE ATRÁS HACIA ADELANTE

REGLA DE TIEMPO DE INICIO MÁS PRÓXIMO  - EL TIP para una actividad que sale de un nodo, es el mayor

de los TTPs de todas las actividades que llegan a ese nodo.

TTP = TIP + t

Para la actividad A TIP(A) =0 TTP(B) = 3 A(0,3)

Para el la actividad B TIP(B) = 0 TTP(B) = 5 B(0,5)

Para la actividad C TIP(C) = 5 TTP(C) = 5 + 3 = 8 C(5,8)

Para la actividad D TIP(C) = 8 TTP(D) = 8 + 4 = 12 D(8,12)

Para la actividad I TIP(I) = 5 TTP(I) = 5 + 5 = 10 I(5,10)

CALCULOS DE ADELANTE HACIA ATRÁS

TIEMPO DE INICIO MÁS LEJANO - Es el tiempo más tardío en que se puede iniciar una actividad  TIL

TIEMPO DE TERMINACIÓN MÁS LEJANO - Es el tiempo más tardío en que se puede terminar una actividad TTL.

TIL = TTL - t

REGLA DE TIEMPO DE TERMINACIÓN MAS LEJANO  - El TTL para una actividad que entra a un nodo, 

es el menor de los TILs para todas las actividades que salen de ese nodo.

TIL = TTL -t

Para la actividad J TTL(J) = 23 TIL(J) = 23 - 3 = 20 J(20,23)

Para la actividad E TTL(E) = 20 TIL(E) = 20 - 8 = 12 E(12,20)

Para la actividad H TTL(H)=20 TIL(H) = 20 - 8 =12 H(12,20)

Para la actividad G TTL(G)=20 TTP(G) = 20 - 4 = 16 G(16,20)

 D(8,12)

   [8,12]

E(12,20)

A(0,3)    [12,20] 

           [5,8] F(8,10) H(10,12)

          [14,16]     [18,20] J(20,23)

[20,23]

G(10,14)

            [16,20]

    B(0,5)     C(5,8)

[0,5]    [5,8]

I(5,10)

[18,20]

HOLGURA  - Es la cantidad de tiempo que una actividad puede retrasarse sin afectar la fecha de

terminación del proyecto general.

Holgura = TIL - TIP = TTL - TTP

Las actividades de la ruta crítica son aquellas con cero holgura

1 4

3

6

52

7

8

9
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Ejercicios: 

1. Elaborar la lista de actividades del proyecto seleccionado en equipo, definir la 

duración de cada actividad y su predecesor inmediato. Presentar a los demás 

miembros del grupo. 

2. Dibujar el Diagrama de red PERT del siguiente proyecto. 

ACTIVIDAD PREDECESOR INMEDIATO DURACIÓN (SEMANAS) 

A - 5 

B - 3 

C A 8 

D A,B 7 

E - 7 

F C,E,D 4 

G F 5 

 

3. Elaborar el Diagrama de red del siguiente proyecto 

ACTIVIDAD PREDECESOR DURACIÓN 

A B 2 

B C 4 

C - 3 

D J,G 8 

E C 40 

F A 3 

G I 32 

H D,F 5 

I C 4 

J A,L 2 

K H,F 4 

L C 3 

 

4.4 Gestión de los costos del proyecto 
La Gestión de los Costos del Proyecto incluye los procesos involucrados en la planificación, 

estimación, preparación del presupuesto y control de costos de forma que el proyecto se 

pueda completar dentro del presupuesto aprobado. 

 

1. Estimación de Costos: Estimar Costos es el proceso que consiste en desarrollar una 

aproximación de los recursos monetarios necesarios para completar las actividades del 

proyecto. 
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ENTRADAS. Línea base del proyecto, programa del proyecto, plan de recursos humanos, 

registro de riesgos, activos de procesos de la organización, factores ambientales de la 

organización. 

 

SALIDAS: estimados de costo de actividades, bases de estimados, actualizaciones de la 

documentación del proyecto. 

 

2. Preparación del Presupuesto de Costos: Determinar el Presupuesto es el proceso que 

consiste en sumar los costos estimados de actividades individuales o paquetes de trabajo 

para establecer una línea base de costos autorizados. 

 

ENTRADAS: estimados de costo de actividades, bases de estimados, línea base del alcance, 

programa del proyecto, calendarios de de recursos, contratos, activos de procesos de la 

organización. 

 

SALIDAS: línea base de desempeño en costos, requisitos de fondeo del proyecto, 

actualizaciones de la documentación del proyecto. 

 

3. Control de Costos: influir sobre los factores que crean variaciones del costo y controlar 

los cambios en el presupuesto del proyecto.  

 

Controlar costos es el proceso por el que se da seguimiento a la situación del proyecto 

para actualizar el presupuesto del mismo y gestionar cambios a la línea base de costo. 

 

ENTRADAS: plan de gestión del proyecto, requisitos de fondeo del proyecto, información 

de desempeño del trabajo y activos de procesos de la organización. 

 

SALIDAS: mediciones de desempeño del trabajo, pronósticos del presupuesto, 

actualización de activos de procesos de la organización, solicitudes de cambio, 

actualizaciones del plan de gestión del proyecto y actualización de la documentación del 

proyecto. 

 

Estos procesos interactúan entre sí y también con los procesos de las demás Áreas de 

Conocimiento. 

 

La Gestión de los Costos del Proyecto se ocupa principalmente del costo de los recursos 

necesarios para completar las actividades del cronograma. Sin embargo, la Gestión de los 

Costos del Proyecto también debería considerar el efecto de las decisiones del proyecto 
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sobre los costos del uso, mantenimiento y soporte del producto, servicio o resultado del 

proyecto. 

 

El plan de gestión de costos puede establecer:  

 

• Nivel de exactitud. Las estimaciones de costos de las actividades del cronograma se 

ajustarán a un redondeo de los datos según una precisión prescrita (por ejemplo, $100, 

$1.000), dependiendo del alcance de las actividades y la magnitud del proyecto, y pueden 

incluir una cantidad para contingencias.  

 

• Unidades de medida. Se definen todas las unidades usadas en las mediciones, como por 

ejemplo, las horas o días de trabajo, la semana de trabajo, la suma global, etc., para cada 

uno de los recursos.  

 

• Enlaces con los procedimientos de la organización. El componente de la EDT usado para 

la contabilidad del costo del proyecto se denomina cuenta de control (CA). A cada cuenta 

de control se le asigna un código o un número de cuenta que está vinculado de forma 

directa con el sistema de contabilidad de la organización ejecutante. Si en la cuenta de 

control se incluyen las estimaciones de costos para los paquetes de planificación, 

entonces también se incluye el método para preparar el presupuesto de los paquetes de 

planificación.  

 

• Umbrales de control. Se pueden definir umbrales de variación para los costos u otros 

indicadores (por ejemplo, días por persona, volumen de producto) en puntos de tiempo 

designados durante el proyecto, para indicar la cantidad acordada de variación permitida.  
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Descripción General de la Gestión de los Costos del Proyecto 
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La estimación de los costos de las actividades del cronograma implica desarrollar una 

aproximación de los costos de los recursos necesarios para completar cada actividad del 

cronograma,  se deben considerar las posibles causas de variación de las estimaciones de 

costos, incluyendo los riesgos.  

 

La estimación de costos incluye la identificación y consideración de diversas alternativas 

de costos. Por ejemplo, en la mayoría de las áreas de aplicación, se considera que el 

trabajo adicional durante la fase de diseño tiene el potencial de reducir el costo de la fase 

de ejecución y de las operaciones de productos. El proceso de estimación de costos evalúa 

si las reducciones de costos esperadas pueden compensar el costo del trabajo adicional de 

diseño.  

 

Las estimaciones de costos generalmente se expresan en unidades monetarias (dólares, 

euros, yen, pesos, etc.) para facilitar las comparaciones tanto dentro de los proyectos 

como entre los proyectos. En algunos casos, el estimador puede utilizar unidades de 

medida para estimar los costos, tales como horas de trabajo o días de trabajo, junto con 

sus estimaciones de costos, para facilitar un adecuado control de gestión.  

 

Las estimaciones de costos pueden mejorarse a través de refinamientos durante el 

transcurso del proyecto para reflejar los detalles adicionales disponibles. La exactitud de la 

estimación de un proyecto aumenta a medida que avanza el proyecto a lo largo del ciclo 

de vida del proyecto. Por ejemplo, un proyecto en la fase de iniciación podría tener una 

estimación aproximada de orden de magnitud (ROM) en el rango de -50 a +100%. En una 

etapa posterior del proyecto, a medida que se tiene más información, las estimaciones 

pueden reducirse a un rango de -10 a +15%. En algunas áreas de aplicación, existen pautas 

sobre cuándo deben efectuarse tales refinamientos y qué grado de exactitud se espera. 7 

 

Los costes de las actividades del cronograma se estiman para todos los recursos que se 

cargarán al proyecto. Esto incluye, entre otros, la mano de obra, los materiales, los 

equipos, los servicios y las instalaciones, así como categorías especiales tales como una 

asignación por inflación o un coste por contingencia. La estimación de costes de una 

actividad del cronograma es una evaluación cuantitativa de los costes probables de los 

recursos necesarios para completar la actividad del cronograma. 
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4.5 Gestión de la Calidad del Proyecto 
La Gestión de la Calidad del Proyecto incluye los procesos y actividades de la organización 

ejecutante que determinan responsabilidades, objetivos y políticas de calidad a fin de que 

el proyecto satisfaga las necesidades por la cuales fue emprendido. Implementa el sistema 

de gestión de calidad por medio de políticas y procedimientos, con actividades de mejora 

continua de los procesos llevados a cabo durante todo el proyecto, según corresponda. 

 
Los procesos de Gestión de la Calidad del Proyecto, a saber: 
 

1. Planificar la Calidad—Es el proceso por el cual se identifican los requisitos de calidad 

y/o normas para el proyecto y el producto, documentando la manera en que el proyecto 

demostrará el cumplimiento con los mismos. 

 

ENTRADAS: línea base del alcance, registro de partes interesadas, línea base de 

desempeño en costos, programa del proyecto, registro de riesgos, factores ambientales 

de la organización, activos de procesos de la organización. 

 

SALIDAS: plan de gestión de calidad, métricas de calidad, listas de verificación de calidad, 

plan de mejoras del proceso, actualizaciones de la documentación del proyecto. 

 

2. Realizar el Aseguramiento de Calidad—Es el proceso que consiste en auditar los 

requisitos de calidad y los resultados de las medidas de control de calidad, para asegurar 

que se utilicen las normas de calidad apropiadas y las definiciones operacionales. 

 

ENTRADAS: plan de gestión del proyecto, métricas de calidad, información de desempeño 

del trabajo y mediciones de control de calidad.  

 

SALIDAS: actualización de activos de procesos de la organización, solicitudes de cambios, 

actualización del plan de gestión del proyecto y actualización de la documentación del 

proyecto. 

 

3. Realizar el Control de Calidad—Es el proceso por el que se monitorean y registran los 

resultados de la ejecución de actividades de control de calidad, a fin de evaluar el 

desempeño y recomendar cambios necesarios. 
 

Puede haber consecuencias negativas graves para algunos interesados en el proyecto e 

incluso para todos. Por ejemplo: 
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• Hacer que el equipo del proyecto trabaje en exceso para cumplir con los requisitos del 

cliente puede ocasionar un importante desgaste de los empleados, errores o reprocesos. 

• Realizar apresuradamente las inspecciones de calidad planificadas para cumplir con los 

objetivos del cronograma del proyecto puede generar errores no detectados. 

 

La gestión moderna de la calidad complementa la dirección de proyectos. Ambas 

disciplinas reconocen la importancia de: 

 

ENTRADAS: plan de gestión del proyecto, métricas de calidad, listas de verificación de 

calidad, mediciones de desempeño del trabajo, solicitudes de cambio aprobadas, 

entregables y activos de procesos de la organización. 

 

SALIDAS: mediciones de control de calidad, cambios validados, entregables validados, 

actualizaciones de activos de procesos de la organización, solicitudes de cambios, 

actualizaciones del plan de gestión del proyecto, actualización de la documentación del 

proyecto. 

 

• La satisfacción del cliente. Entender, evaluar, definir y gestionar las expectativas, de 

modo que se cumplan los requisitos del cliente. Esto requiere una combinación de 

conformidad con los requisitos (para asegurar que el proyecto produzca aquello para lo 

cual fue emprendido) y adecuación para su uso (el producto o servicio debe satisfacer 

necesidades reales). 

 

• La prevención antes que la inspección. Uno de los preceptos fundamentales de la 

gestión moderna de la calidad establece que la calidad se planifica, se diseña y se integra 

(y no se inspecciona). Por lo general, el costo de prevenir errores es mucho menor que el 

de corregirlos cuando son detectados por una inspección. 

 

• La mejora continua. El ciclo planificar-hacer-revisar-actuar es la base para la mejora de 

la calidad, según la definición de Shewhart, modificada por Deming. Además, las iniciativas 

de mejora de la calidad emprendidas por la organización ejecutante, tales como TQM y Six 

Sigma, deben mejorar tanto la calidad de la dirección del proyecto, como la del producto 

del proyecto.  

 

• La responsabilidad de la dirección. El éxito requiere la participación de todos los 

miembros del equipo del proyecto, pero proporcionar los recursos necesarios para lograr 

dicho éxito sigue siendo responsabilidad de la dirección. El costo de la calidad se refiere al 
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costo total de todos los esfuerzos relacionados con la calidad a lo largo del ciclo de vida 

del proyecto. 

4.6 Gestión de los Recursos Humanos del Proyecto 
La Gestión de los Recursos Humanos del Proyecto incluye los procesos que organizan, 

gestionan y conducen el equipo del proyecto. El equipo del proyecto está conformado por 

aquellas personas a las que se les han asignado roles y responsabilidades para completar 

el proyecto.  

 

El tipo y la cantidad de miembros del equipo del proyecto pueden variar con frecuencia, a 

medida que el proyecto avanza. Los miembros del equipo del proyecto también pueden 

denominarse personal del proyecto. Si bien se asignan roles y responsabilidades 

específicos a cada miembro del equipo del proyecto, la participación de todos los 

miembros en la toma de decisiones y en la planificación del proyecto puede resultar 

beneficiosa.  

 

La intervención y la participación tempranas de los miembros del equipo les aportan su 

experiencia profesional durante el proceso de planificación y fortalecen su compromiso 

con el proyecto. 

 

Un panorama general de los procesos de Gestión de los Recursos Humanos del Proyecto, a 

saber: 

 

1. Desarrollar el Plan de Recursos Humanos—Es el proceso por el cual se identifican 

y documentan los roles dentro de un proyecto, las responsabilidades, las habilidades 

requeridas y las relaciones de comunicación, y se crea el plan para la dirección de 

personal. 

 

ENTRADAS: requisitos de recursos para actividades,  activos de procesos de la 

organización, factores ambientales de la organización. 

 

SALIDAS: plan de recursos humanos. 

 

2. Adquirir el Equipo del Proyecto—Es el proceso por el cual se confirman los recursos 

humanos disponibles y se forma el equipo necesario para completar las asignaciones del 

proyecto. 
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ENTRADAS: plan de gestión del proyecto, factores ambientales de la organización y activos 

de procesos de la organización.  

 

SALIDAS: asignación de personal para el proyecto, calendario de recursos, actualización 

del plan de gestión del proyecto. 

 

3. Desarrollar el Equipo del Proyecto—Es el proceso que consiste en mejorar las 

competencias, la interacción de los miembros del equipo y el ambiente general del 

equipo para lograr un mejor desempeño del proyecto. 

 

ENTRADAS: asignación de personal para el proyecto, plan de gestión del proyecto,  

calendario de recursos. 

 

SALIDAS: evaluaciones de desempeño del equipo, actualización de factores ambientales 

de la organización. 

 

4. Dirigir el Equipo del Proyecto—Es el proceso que consiste en dar seguimiento al 

desempeño de los miembros del equipo, proporcionar retroalimentación, resolver 

problemas y gestionar cambios a fin de optimizar el desempeño del proyecto. 

 

ENTRADAS: asignación de personal para el proyecto, plan de gestión del proyecto,  

evaluaciones de desempeño del  equipo, reportes de desempeño,  activos de procesos de 

la organización. 

 

SALIDAS: actualización de factores ambientales de la organización, actualización de activos 

de procesos de la organización, solicitudes de cambio, actualización del plan de gestión 

del proyecto. 
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Si no se cuenta con recursos adecuados, los programas que se hagan no son realistas, lo 

cual al final causa frustración al equipo por no lograr los resultados. 

 

El primer problema que se presenta es si se cuenta con las personas con las competencias 

necesarias para realizar las tareas planeadas y después habrá que preguntarse si pueden 

ser asignadas a tiempo completo o sa tiempo parcial. Es necesario considerar los tiempos 

que se reducen de las jornadas por Ingeniería Industrial (necesidades personales, fatiga y 

esperas), lo que puede tomar hasta 20% del tiempo laboral. En las organizaciones, la 

disponibilidad del personal para ser asignados a proyectos es del 50 a 60%. 

 

Otra dificultad que se presenta es la participación del personal en otros proyectos, 

reduciendo la disponibilidad del personal hasta al 20%. 

 

Con las nuevas tendencias de la organización Lean, los recursos para proyectos cada vez 

son más escasos (algunas organizaciones se han adelgazado tanto que pueden morir de 

anorexia), en el organismo la grasa proporciona reservas para los tiempos duros, pero no 

nos hemos dado cuenta de esto. Conforme la capacidad de un sistema tiende al 100%, el 

tiempo de espera para utilizarlo tiende al infinito. 

 

Estas mismas ideas se aplican a los recursos, como el personal opera en su límite, el 

tiempo que deben esperar los proyectos tiende a infinito. 

 

El tiempo extra no es una solución ya que después de trabajar varias semanas de 50 a 60 

horas, la productividad cae al nivel de las 40 horas y los errores se elevan, por el cansancio 

y la fatiga. Otro factor que afecta es la concentración de mucha gente en un mismo 

departamento. Es importante contar con personal multihabilidades que puedan trabajar 

en equipo. 

 

Con objeto de nivelar las cargas de trabajo en proyectos complejos, es necesario el uso de 

computadoras, donde haya los menores tiempos de holgura sin ejecución para las 

actividades. 
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4.7 Gestión de las Comunicaciones del Proyecto 
La Gestión de las Comunicaciones del Proyecto incluye los procesos requeridos para 

garantizar que la generación, la recopilación, la distribución, el almacenamiento, la 

recuperación y la disposición final de la información del proyecto sean adecuados y 

oportunos.  

 

Los directores del proyecto pasan la mayor parte del tiempo comunicándose con los 

miembros del equipo y otros interesados en el proyecto, tanto si son internos (en todos 

los niveles de la organización) como externos a la misma. Una comunicación eficaz crea un 

puente entre los diferentes interesados involucrados en un proyecto, conectando 

diferentes entornos culturales y organizacionales, diferentes niveles de experiencia, y 

perspectivas e intereses diversos en la ejecución o resultado del proyecto. 

 

Una descripción general de los procesos de Gestión de las Comunicaciones del Proyecto, a 

saber: 

 

1. Identificar a los Interesados—Es el proceso que consiste en identificar a todas las 

personas u organizaciones impactadas por el proyecto, y documentar información 

relevante relativa a sus intereses, participación e impacto en el éxito del mismo. 

 

2. Planificar las Comunicaciones—Es el proceso para determinar las necesidades de 

información de los interesados en el proyecto y definir cómo abordar las 

comunicaciones con ellos. 

 

ENTRADAS: registro de partes interesadas, estrategia de gestión de partes interesadas, 

activos de procesos de la organización, factores ambientales de la organización. 

 

SALIDAS: plan de gestión de comunicaciones, actualizaciones de la documentación del 

proyecto. 

 

3. Distribuir la Información—Es el proceso de poner la información relevante a 

disposición de los interesados en el proyecto, de acuerdo con el plan establecido. 

 

ENTRADAS: plan de gestión del proyecto,  reportes de desempeño,  activos de procesos de 

la organización. 

 

SALIDAS: actualización de activos de procesos de la organización. 
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4. Gestionar las Expectativas de los Interesados—Es el proceso de comunicarse y 

trabajar en conjunto con los interesados para satisfacer sus necesidades y abordar 

los problemas conforme se presentan. 

 

ENTRADAS: registro de partes interesadas, estrategia de gestión de partes interesadas, 

plan de gestión del proyecto, bitácora de problemas,  bitácora de cambios, activos de 

procesos de la organización. 

 

SALIDAS: actualización de activos de procesos de la organización, solicitudes de cambio, 

actualizaciones del plan de gestión del proyecto, actualización de la documentación del 

proyecto. 

 

5. Informar el Desempeño—Es el proceso de recopilación y distribución de la 

información sobre el desempeño, incluyendo los informes de estado, las mediciones 

del avance y las proyecciones. 

 

ENTRADAS: plan de gestión del proyecto, información de desempeño del trabajo, 

mediciones de desempeño del trabajo, pronósticos de presupuesto y activos de procesos 

de la organización. 

 

SALIDAS: reportes de desempeño, solicitudes de cambio y actualizaciones de activos de 

procesos de la organización. 

 

Los procesos anteriores interactúan entre sí y con procesos de las otras áreas de 

conocimiento.  

Cada proceso se ejecuta por lo menos una vez en cada proyecto y en una o más fases del 

proyecto, en caso de que el mismo esté dividido en fases. Aunque los procesos se 

presentan aquí como componentes diferenciados con interfaces bien definidas, en la 

práctica se superponen e interactúan en formas que no se detallan aquí. 

Las dimensiones posibles de la actividad de comunicación son, entre otras: 

•  Interna (dentro del proyecto) y externa (cliente, otros proyectos, medios de 

comunicación, público) 

•  formal (informes, memorandos, instrucciones) e informal (correos electrónicos, 

conversaciones ad hoc) 

•  vertical (hacia arriba y abajo dentro de la organización) y horizontal (entre colegas) 

•  oficial (boletines, informe anual) y no oficial (comunicaciones extraoficiales) 

•  escrita y oral 

•  verbal y no verbal (inflexiones de voz, lenguaje corporal) 
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Los informes de desempeño se emiten de manera periódica y su formato puede variar 

desde un simple informe de estado hasta informes más elaborados. Un informe de estado 

simple puede mostrar información sobre el desempeño, como el porcentaje completado o 

los indicadores de estado para cada área (p.ej., el alcance, el cronograma, los costos y la 

calidad). 

 

Entre los informes más elaborados, se incluyen: 

• el análisis del desempeño pasado 

• el estado actual de los riesgos e incidentes 

• el trabajo completado durante el período reportado 

• el trabajo que deberá completarse durante el siguiente período de reporte 

• el resumen de los cambios aprobados en el período 

• los resultados del análisis de variación 

• la conclusión proyectada del proyecto (incluido el tiempo y el costo) 

• otra información relevante que debe ser revisada y analizada 

 

4.8 Gestión de los Riesgos del Proyecto 
La Gestión de los Riesgos del Proyecto incluye los procesos relacionados con llevar a cabo 

la planificación de la gestión, la identificación, el análisis, la planificación de respuesta a los 

riesgos, así como su monitoreo y control en un proyecto. Los objetivos de la Gestión de los 

Riesgos del Proyecto son aumentar la probabilidad y el impacto de eventos positivos, y 

disminuir la probabilidad y el impacto de eventos negativos para el proyecto. 

 

Una descripción general de los procesos de Gestión de los Riesgos del Proyecto, a saber: 

 

1. Planificar la Gestión de Riesgos—Es el proceso por el cual se define cómo 

realizar las actividades de gestión de los riesgos para un proyecto. 

 

ENTRADAS: estatuto del alcance del proyecto, plan de gestión de costos, plan de gestión 

del programa, plan de gestión de comunicaciones, activos de procesos de la organización, 

factores ambientales de la organización. 

 

SALIDAS: plan de gestión de riesgos. 

 

2. Identificar los Riesgos— Identificar Riesgos es el proceso por el cual se determinan los 

riesgos que pueden afectar el proyecto y se documentan sus características. 
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ENTRADAS: plan de gestión de riesgos, estimados de costos de actividades, estimado de 

duración de actividades, línea base del alcance, registro de partes interesadas, plan de 

gestión de costos, plan de gestión del programa, plan de gestión de calidad, documentos 

del proyecto, activos de procesos de la organización, factores ambientales de la 

organización. 

 

SALIDAS: registro de riesgos. 

 

3. Realizar el Análisis Cualitativo de Riesgos— Realizar Análisis Cualitativo de Riesgos es el 

proceso que consiste en priorizar los riesgos para realizar otros análisis o acciones 

posteriores, evaluando y combinando la probabilidad de ocurrencia y el impacto de dichos 

riesgos. 

 

ENTRADAS: registro de riesgos, plan de gestión de riesgos, estatuto del alcance del 

proyecto, activos organizaciones de procesos. 

 

SALIDAS: actualización del registro de riesgos. 

 

4. Realizar el Análisis Cuantitativo de Riesgos—Es el proceso que consiste en 

analizar numéricamente el efecto de los riesgos identificados sobre los objetivos 

generales del proyecto. 

 

ENTRADAS: registro de riesgos, plan de gestión de riesgos, plan de gestión de costos, plan 

de gestión del programa, activos organizaciones de procesos. 

 

SALIDAS: actualización del registro de riesgos 
 

5. Planificar la Respuesta a los Riesgos— Planificar la Respuesta a los Riesgos es el 

proceso por el cual se desarrollan opciones y 

acciones para mejorar las oportunidades y reducir las amenazas a los objetivos del 

proyecto. 
 

ENTRADAS: registro de riesgos, plan de gestión de riesgos.  

 

SALIDAS: actualización del registro de riesgos, decisiones al contrato en relación a riesgos, 

actualización del plan de gestión del proyecto y actualización de la documentación del 

proyecto. 
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6. Monitorear y Controlar los Riesgos— Dar Seguimiento r y Controlar los Riesgos es el 

proceso por el cual se implementan planes de respuesta a los riesgos, se da seguimiento a 

los riesgos identificados, se da seguimiento a los riesgos residuales, se identifican nuevos 

riesgos y se evalúa la efectividad del proceso contra riesgos a través del proyecto. 

 

ENTRADAS: registro de riesgos, plan de gestión del proyecto, información del desempeño 

del trabajo, reportes de desempeño. 

 

SALIDAS: actualización del registro de riesgos, actualización de activos de procesos de la 

organización, solicitudes de cambios, actualizaciones del plan de gestión del proyecto, 

actualización de la documentación del proyecto. 
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4.9 Gestión de las Adquisiciones del Proyecto 
La Gestión de las Adquisiciones del Proyecto incluye los procesos de compra o 

adquisición de los productos, servicios o resultados que es necesario obtener fuera del 

equipo del proyecto. La organización puede ser la compradora o vendedora de los 

productos, servicios o resultados de un proyecto.  

 

La Gestión de las Adquisiciones del Proyecto incluye los procesos de gestión del contrato y 

de control de cambios requeridos para desarrollar y administrar contratos u órdenes de 

compra emitidas por miembros autorizados del equipo del proyecto.  

 

La Gestión de las Adquisiciones del Proyecto también incluye la administración de 

cualquier contrato emitido por una organización externa (el comprador) que esté 

adquiriendo el proyecto a la organización ejecutante (el vendedor), así como la 

administración de las obligaciones contractuales contraídas por el equipo del proyecto en 

virtud del contrato. 
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Una descripción general de los procesos de Gestión de las Adquisiciones del Proyecto, a 

saber: 

 

1. Planificar las Adquisiciones—Es el proceso de documentar las decisiones de 

compra para el proyecto, especificando la forma de hacerlo e identificando a 

posibles vendedores. 

 

ENTRADAS: Línea base del alcance, requisitos de la documentación, acuerdos de 

capacitación, registro de riesgos, decisiones de contrato con relación al riesgo, requisitos 

de recursos de actividades, programa del proyecto, estimados de costos de actividades, 

línea base de desempeño en costo, factores ambientales de la organización y activos de 

procesos de la organización.  

 

SALIDAS: plan de gestión de suministros, enunciado de suministros, decisiones de comprar 

o hacer, documentos de suministros, criterios de selección de proveedores, cambios a 

requisiciones. 

 

2. Efectuar las Adquisiciones—Es el proceso de obtener respuestas de los 

vendedores, seleccionar un vendedor y adjudicar un contrato. 

 

ENTRADAS: plan de gestión del proyecto, documentos de compras, criterios de selección 

de proveedores, lista de proveedores calificados,  documentos del proyecto, decisiones de 

comprar o hacer, acuerdos de capacitación y activos de procesos de la organización. 

 

SALIDAS: proveedores seleccionados, liberación de contratos de suministros, calendario 

de recursos, actualización del plan de gestión del proyecto y actualización de documentos 

del proyecto. 

 

3. Administrar las Adquisiciones— Administrar las Adquisiciones es el proceso que 

consiste en gestionar las relaciones de adquisiciones, supervisar el desempeño del 

contrato y efectuar cambios y correcciones según sea necesario. 

 
ENTRADAS: documentos de suministros, plan de gestión del proyecto, contratos, reportes 

de desempeño, solicitudes de cambio aprobadas, información de desempeño del trabajo.   

 

SALIDAS: documentación de suministros, actualizaciones de activos de procesos de la 

organización, solicitudes de cambios y actualizaciones del plan de gestión del proyecto. 
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4. Cerrar las Adquisiciones—Es el proceso de completar cada adquisición para el 

proyecto. 

 

ENTRADAS: plan de gestión del proyecto, documentación de suministros.    

 

SALIDAS: suministros entregados, actualizaciones de activos de procesos de la 

organización. 

4.10 Gestión de la ejecución del proyecto 
El Grupo del Proceso de Ejecución está compuesto por aquellos procesos realizados para 

completar el trabajo definido en el plan para la dirección del proyecto a fin de cumplir con 
las especificaciones del mismo. 

a)  Dirigir y Gestionar la Ejecución del Proyecto 

Dirigir y Gestionar la ejecución del proyecto es el proceso que consiste en ejecutar el 

trabajo definido en el plan para la dirección del proyecto para cumplir con los objetivos 

del proyecto. 

 

ENTRADAS: plan de gestión del proyecto, solicitudes de cambios aprobadas, factores 

ambientales de la organización y activos de procesos de la organización.  

 

SALIDAS: Entregables, información de desempeño del trabajo, solicitudes de cambios, 

actualización del plan de gestión del proyecto y actualización de la documentación del 

proyecto. 

4.11 Cierre del proyecto 
Cerrar el Proyecto o Fase es el proceso que consiste en finalizar todas las actividades a 

través de todos los grupos de procesos de dirección de proyectos para completar 

formalmente el proyecto o una fase del mismo. 

 

ENTRADAS: plan de gestión del proyecto, entregables aceptados, activos de procesos de la 

organización.    

 

SALIDAS: producto, servicio o transición final y actualizaciones de activos de procesos de 

la organización. 
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Durante el proyecto se va haciendo seguimiento del desempeño del proyecto, tanto en 

avances como en variaciones contra presupuestos, para lo cual se van elaborando una 

serie de reportes a ser revisados por la dirección durante el desarrollo del proyecto: 

 

Reporte de logro de metas intermedias (milestones): 

 Permiten reenfocar prioridades para los objetivos a más largo plazo.   

 Son puntos de decisión para continuar o no el proyecto, son visibles 

 
Reporte final 

 Reporte de cumplimiento de objetivos 

 Comparación de beneficios y costos reales contra presupuesto 

 Cumplimiento de metas intermedias 

 Análisis “Post Mortem”, que estuvo bien y que estuvo mal como herramienta de 

aprendizaje 

 

El éxito de un proyecto da respuesta positiva a las preguntas siguientes o con beneficios 

relevantes: 

 ¿Se lograron las metas y objetivos planeados? 

 ¿Se cumplieron las fechas de terminación? 

 ¿Dentro o por debajo de las restricciones de costo? 

 ¿Se utilizaron los recursos asignados? 

 

El desempeño y éxito de un proyecto se mide en resultados no en el esfuerzo dedicado al mismo. 

Una vez finalizado el proyecto, se entrega al cliente o al dueño del proceso para su seguimiento, se 

le transfiere la tecnología y se proporciona capacitación.  

a) Lecciones aprendidas 

Las variaciones identificadas durante el desarrollo del proyecto se explican y las “lecciones 

aprendidas” del proyecto se documentan y se difunden a los diferentes niveles de la organización 

involucrados en el proyecto. 

 

El anuncio a los grupos interesados y clientes sobre la terminación del proyecto, previene a los 

gerentes a disponer del personal que asignaron al proyecto. En la reunión pública se inicia la 

transición de los entregables del proyecto a las funciones de línea y se reconocen los logros del 

equipo.         http://aggiechick03.blogspot.com/ 

 

http://aggiechick03.blogspot.com/
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5. Uso de Microsoft Project 2007 

5.1 Introducción 
Ejecutar Project 2007 con: Microsoft Office  >  Microsoft Project 2007 

Para abrir un archivo nuevo: 

File > New  

 

 
 

En la pantalla de información de proyecto indicar la fecha inicial o final del proyecto: 

 

Project > Project information 

 
 

Para salvar el archivo del proyecto: 

File > Save as > Proyecto 1 (en la carpeta deseada)   
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Previo a cargar las actividades, es necesario realizar por separado una estructura detallada 

de actividades (work breakdown structure – WBS) como la siguiente, endentar las 

actividades conforme sea necesario. 

 
 

Agregar nombres de Actividades o tareas principales y secundarias, la duración de 

Default es un día: 

 
 

3er. nivel

2do. nivel

1er. nivel
Proyecto, metas 

y resultados 
principales

Objetivos, fases, 
departamentos o 
grupos de trabajo 

principalesDividir cada uno de 
los anteriores en 

tareas, actividades 
o eventos 

intermedios 
requridos para 
completar el 

proyecto

Dividir cada uno de los 
anteriores en tareas, 
actividades o eventos 
intermedios requridos 

para completar el 
proyecto

Objetivos, 
fases, 

departamentos 
o grupos de 

trabajo 
principales
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Los nombres de las tareas deben ser claros y sin ambigüedades, que permitan realizare 

estimados de tiempo, costos y duración de manera sencilla. Las metas intermedias o 

puntos de revisión, confirma que las tareas antecesoras se han completado, el uso de un 

verbo de resultados es apropiado para comunicar la importancia de la revisión de puntos 

intermedios, tales como: prueba completa, usuarios entrenados, aprobación recibida, etc. 

 

Tareas resumen, son subtituladas dentro de la lista de tareas, para agrupación de tareas 

en una tarea resumen. Endentar tareas seleccionándolas debajo de la tarea resumen y 

pulsar el botón                 ponerlas en secuencia con el botón de ligar tareas  

 

 

Las tareas se pueden desligar o eliminar su secuencia con el botón  

 

También se pueden ligar o secuenciar de manera gráfica moviendo las barras inferiores 

en secuencia como sigue: 

 

 
 

Para expandir o contraer la lista de tareas se utilizan los botones de los signos + y – 
como sigue:  



Administración efectiva de Proyectos gubernamentales   Dr. Primitivo Reyes A. /oct. 2011 

69 
 

 
 

 

 
 

 
 

Para imprimir la lista de tareas o actividades: 

 

Para imprimir todo el diagrama de Gantt en una sola página, dar un click derecho en la 

escala de fechas. Seleccionar ZOOM y ENTIRE PROJECT. 

 

  
 

File > Print preview  o con  
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La escala de tiempo también se puede ajustar con TIMESCALE: 

 
Ajustar la escala de tiempo y el tamaño conforme sea requerido. 

Las columnas no deseadas se pueden esconder con la opción HIDE. 

 

Se puede ajustar la página con  PAGE SETUP: 
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5.2 Estimación de la duración de actividades 
La duración completa del programa del proyecto depende de que tan bien se estime la 

duración de las tareas individuales y contestar estas preguntas: 

 ¿Cuánto dura el proyecto? 

 ¿Cuándo se puede terminar? 

 ¿Cuándo se puede iniciar? 

 ¿Hay flexibilidad en el programa? 

 

Un programa exacto ayuda a mantenerse en control y se puede ajustar o adaptar para 

cumplir con las condiciones y condiciones reales. Por ejemplo, si la gente clave para el 

avance del proyecto está ocupada en otras cosas, ¿Cuáles son las opciones? ¿hay 

alternativas de recursos, se puede retrasar el inicio de las tareas, se puede cambiar el 

enfoque completo? 

a) Estimación de la duración de tareas 

Hay seis formas fundamentales de estimar la duración de las tareas, se pueden aplicar 

dependiendo de la situación: 

 Con datos históricos 
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 Con referencia a experiencias de otros o estándares de tareas  

 A sentimiento (Wildly Aimed Guess – WAG), se pueden dividir las áreas en 

componentes más pequeños para reducir el error. 

 A sentimiento con referencia a una experiencia similar (Scientific WAG – SWAG) 

 Con el Método Delphi, un grupo de expertos multifuncionales se les pide que 

estimen de manera independiente la duración de las tareas en cuestión. Después 

cada uno explica sus razones al grupo, después con el beneficio del racional de 

otros, se realiza otra ronda de estimados, repitiendo hasta que haya un fuerte 

consenso de opinión. 

 Análisis PERT, utiliza el poder de la probabilidad y de la estadística para mejorar la 

exactitud de los estimados. Se hacen tres estimados de la duración de la tarea: uno 

optimista, uno pesimista y el más probable o esperado. En caso de que el esperado 

no se encuentre en el centro, PERT hace las ponderaciones necesarias, por ejemplo 

si 12 hrs, 32 hrs, y 100 hrs, son los valores optimista, esperado y pesimista, PERT le 

da un peso de cuatro veces al esperado =(pesimista + optimista + 4*esperado)/6 = 

40 hrs. 

 

Introducir la duración de cada una de las tareas: 

En días (d),  semanas (w), meses (mo)….. 

Se reemplaza la duración por omisión o default de 1 día?  - el signo de interrogación es 

indicado por Project cuando la duración es timada por el mismo programa. Por ejemplo  

se tienen las estimaciones de tiempo como sigue: 

 

 
 

Estimación de tiempo con PERT: 

Se utilizan las opciones siguientes:           En esta ventana se ingresan los datos de tiempos  
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View > Toolbars > PERT Analysis             Optimista, Esperado y Pesimista. Contestar SI. 

Pulsar el botón PERT Entry Sheet 

 
   

 
Después pulsar el botón CALCULATE PERT  para estimar la duración del proyecto:  

PERT determina nuevas duraciones que cambian las duraciones originales establecidas 

para las tareas (solo en las que se ingresaron tiempos de duración Optimista, Esperada y 

Pesimista):  Queda como sigue: 

 
 
Para regresar a la vista original del Gantt, View > Gantt Chart  
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b) Manejo del tiempo y calendario 

Por Default cada día consta de 8 horas, cada semana de 40 horas y cada mes de 20 días 
hábiles. Un día hábil tiene un horario de 8:00 AM a 5:00 PM, si se quieren cambiar estas 
opciones, seguir las instrucciones siguientes: 
 
Tools >Options > Calendar 
 
Se utiliza la notación siguiente para el tiempo transcurrido: 

  
 

  
 

Secuencia de tareas para cubrir las necesidades 

La secuencia de tareas y el tiempo requerido para completar el proyecto está 

determinado por las relaciones de dependencia entre las tareas. Las tareas en paralelo 

acortan la duración del proyecto y las tareas dependientes no pueden iniciar hasta que 
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terminen sus predecesoras. 

 
 

Para asignar tareas predecesoras, mover la línea de división hacia la derecha hasta que 

esté visible la columna de Predecesores, si hay columnas sin uso se pueden esconder 

(Hide). 

 

 
 

Revisar desde el inicio de la lista de tareas e identificar cuales tareas deben preceder a la 

actual, si no hay ninguna, dejar la columna en blanco. Colocar el número de ID del 

predecesor en el CAMPO DE PREDECESOR, por ejemplo las tareas 3, 4 y 5 tienen 

predecesoras 1, 3 y 4 respectivamente.  

 

 
 

Si hay más tareas predecesoras, separar los números de ID con una coma, por ejemplo la 

tarea 10 tiene predecesores 7, 8 y 9: 
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Otra forma es mover la barra de la tarea predecesora a la barra de la tarea dependiente: 

 
Una vez introducidas todas las dependencias del programa, se puede revisar el flujo de 

trabajo, la duración total del proyecto y los posibles cuellos de botella. 

 

Para otras dependencias más complejas con tipo de predecesor y retraso en el inicio o 

final, seleccionar la tarea deseada y Task Information: 

 
Por ejemplo para que la tarea 13 inicie con un retraso de 0.3 días después de la tarea 12 

se tiene: 

 
 

 
 

También se pueden utilizar restricciones con palabras:  



Administración efectiva de Proyectos gubernamentales   Dr. Primitivo Reyes A. /oct. 2011 

77 
 

ASAP – Tan pronto como seaposible; ALAP – Tan tarde como seaposible; FNLT – No 

terminar después de; SNLT – no iniciar después de; FNET – no terminar antes de; SNET – 

iniciar no antes que; MSO – debe iniciar en; MFO – debe terminar en. Las opciones 

anteriores se ejecutan independientemente de las dependencias. 

 

Se configuran al seleccionar la tarea deseada y Task Information  Advanced: 

Si se configura para AS LATE AS POSSIBLE: 

 
 

Se obtiene: 

 

 
 

Para hacer que el proyecto sea más fácil de manejar y exitoso, seguir estas reglas: 

 Iniciar todo tan pronto como sea posible. 

 Mantener el flujo de trabajo lógico y tan simple como sea posible. 

 Utilizar las restricciones con cuidado, y solo si son necesarias. 

 Mantener el plan tan flexible como sea posible. 

 Hacer un buen programa, simple. 

5.3 Manejo de recursos, costos y presupuestos 
El preparar y dar seguimiento a la planeación de los recursos permite alcanzar los 
siguientes objetivos: 

 Se puede programar de acuerdo a los recursos disponibles, además de la secuencia 
de tareas y su duración. 

 Se pueden identificar los cuellos de botella causados por limitaciones de recursos. 

 Se pueden programar y dar seguimiento a costos del proyecto completo, y de cada 
recurso. 

 Se pueden distribuir las cargas de trabajo de manera justa en el equipo. 
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Manejo de recursos 
MS Project maneja los siguientes tipos de recursos: personas, instalaciones, equipos y 
materiales y costos los tres primeros se combinan en una sola categoría Work resources 
(recursos de trabajo).  Para crear una lista de recursos: 
 
Se pueden agregar en la Gráfica de Gantt de las actividades o en un menú especial para 
introducir los datos de los recursos como sigue: 
View > Table:Entry Entry  o   View > Resource Sheet 
 

Se abre una página con los campos siguientes: 

 
 

En la columna de indicador puede aparecer un Ícono de precaución (Warning icon) para 

indicar que no hay suficientes recursos para realizar el proyecto. Los recursos pueden ser 

personalizados después en la caja de Información de Recursos. 

 

Indicator – columna para proporcionar información de alerta; Resource name –  texto o 

número para identificar el recurso; Type – labor o material; Material Label – unidad de 

medición para costeo, ft, m, ton, kg, etc; Initials – iniciales de la persona; Group – nombre 

de la cuadrilla para reportes separados; Max. Units – indicar el porcentaje que de este 

recurso está disponible en el proyecto; Std. Rate – costo por unidad del recurso (default 

por hora (h), semana (w), día (d); escribir la tasa / unidad, por ejemplo $45,000/y); Ovt. 

Rate – monto de tiempo extra para el recurso; Cost/Use – cargo único para el recurso; 

Accrue at – el costo prorrateado de acuerdo al avance del proyecto se puede modificar;  

 

Se puede ingresar información detallada de los recursos al seleccionar el renglón de 

recursos y seleccionar RESOURCE INFORMATION,  aparece la siguiente pantalla para 

ingresar los datos incluyendo los costos: 
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Dentro de este cuadro se puede ingresar el e-mail para comunicación con otros miembros 

del equipo. 

 

Costos fijos 
Otro método para agregar costos para el proyecto es agregar un costo fijo a cada tarea.  
 

View > Table Entry: Cost  

 

  

El campo FIXED COST ACCRUAL sirve para indicar si el costo se carga al inicio del proyecto, 

al final o se prorratea durante su duración. 

 

Calendario, recursos y tiempo a ponderar 
El programa proporciona varios tipos de calendarios: calendario estándar, calendario 

base, calendario del proyecto y calendario de recursos. 

 

El calendario estándar se puede configurar a un turno por día, 8 horas (8 a.m. a 5 p.m.), 

lunes a viernes. El calendario de turno de la noche es de 8 horas de 11 p.m. a 8 a.m., lunes 

a viernes; y el último es un calendario de 24 horas los 365 días del año (para maquinaria).   

 

No hay días festivos en los calendarios, se les pueden agregar paros de planta, días de 

descanso, etc. Para hacer cambios: 
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Tools > Change Working time New  

 

Seleccionar un nuevo calendario para la organización y llenar el cuadro de EXCEPTIONS 

con los días a modificar para configurar los días no laborales. 

 
 
El calendario para el proyecto se selecciona en: 
 
Project > Project information 

 
 
 
Si el calendario seleccionado no se apega perfectamente al calendario de los recursos 

(vacaciones, etc.) modifica su calendario para que se tome en cuenta. Seleccionar el 

recurso con: 
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View > Resource sheet    
 

 
 

Asignación de recursos -  cargas 
Antes de asignar los recursos a las tareas o actividades considerar lo siguiente: 

 ¿Qué tan importante es la calidad en esta tarea? 

 ¿Qué tan crítico es el tiempo en esta tarea? 

 ¿El flujo del proyecto depende de la terminación de esta tarea? 

 ¿Qué habilidades son necesarias para completar esta tarea? 

 ¿Si se aplican más recursos la tarea se puede terminar en menos tiempo, de mejor 

forma, más segura o más barata? 



Administración efectiva de Proyectos gubernamentales   Dr. Primitivo Reyes A. /oct. 2011 

82 
 

 ¿Puede hacerse esta tarea más lenta, postergarse o hacerse en etapas sin un 

efecto adverso? 

 

El Project asume que las tareas son impulsadas por el esfuerzo (se asume que si se le 

asignan más recursos a las tareas, se terminan más pronto). Algunas tareas no responden 

a la adición de recursos, estas se denominan Tareas de duración fija (crecimiento del 

pasto). 

 

  
 

Para asignar recursos, en la pantalla de gráfica de Gantt dividir la pantalla colocando el 

cursos en algún lado y  

 

WINDOW > SPLIT    

 

seleccionar FORMAT > DETAILS > RESOURCES AND PREDECESSORS 

 

  

Asegurarse que la opción cálculo automático esté activada: 
 

Tools > Options > Calculate    Automatic 
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Se pueden asignar recursos a cada una de las tareas (no necesariamente el 100%, puede 

ser el 50%), seleccionándola y con botón derecho llamar a Task information > Resources: 

 
En este menú se pueden varias combinaciones de asignación de recursos. 

 

Cuando no se tienen suficientes recurso para el proyecto, se pueden hacer varias cosas: 

 

 Obtener más recursos 

 Reducir el alcance del proyecto 

 Trabajar más tiempo con los recursos disponibles. 

 

Otras medidas son: 

 

Si no hay suficiente de …. Intentar esto…. 

Gente Postergar las tareas 
Solicitar más tiempo para el proyecto 
Balancear las habilidades con las tareas  
Dividir las tareas en actividades simples y 
proporcionar ayuda 
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Agregar personal de tiempo parcial o a  
tiempo completo 
Utilizar contratistas 
Comprar en vez de hacer 
Limitar el alcance del proyecto 
 

Tiempo Asignar más recursos 
Trabajar tiempo extra 
Revisar secuencia del flujo de trabajo 
Usar servicios externos 
Comprar más que hacer 
Limitar alcance del proyecto 
Apoyarse en asistentes junior 

Materiales Revisar la secuencia del flujo de trabajo 
para reprogramar tareas paralelas 
Utilizar proveedores alternos 
Reconsiderar hacer o comprar 
Solicitar una extensión de tiempo 

Instalaciones Revisar la secuencia del flujo de trabajo 
para reprogramar tareas paralelas 
Trabajar turnos adicionales 

Falta general de recursos Revisar la definición del proyecto y 
seleccionar una estrategia más realista 

 

Si se establece en la opción de Fecha inicial del proyecto: 

Project > Project information  > Schedule from > Project start date 

 
 

Project intenta iniciar las tareas lo más pronto posible, dependiendo de la duración de 

cada tarea y las dependencias de sus predecesoras. Se agregan las duraciones de las 

tareas en la ruta crítica para estimar la duración total del proyecto. 

 

Cuando se establece la opción de Fecha final del proyecto: 

Project > Project information  > Schedule from > Project finish date 
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Las tareas en la ruta crítica se inician tan tarde como sea posible. Se agrega la duración de 

cada tarea predecesora, desde la fecha final del proyecto, en reversa hasta la primera 

tarea, de modo de determinar cuándo iniciar la primera tarea. 

 

Si no se asignan recurso a la tarea, se programa para tener la máxima duración posible, en 

el momento que se le asignan recursos, se ajusta su duración. 

 

La ruta crítica 
Se puede visualizar en: 
 
View > Network Diagram    Critical tasks 
 

 
O  

 

View > More views > Detail Gantt     
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Las barras rojas representan la ruta crítica y las barras azules las actividades con holgura 

(que aparece como líneas delante de la tarea o actividad), esto para efectos de toma de 

decisiones en el proyecto. 

 

Encontrar sobre asignación de recursos. 
Se pueden observar en la vista de Resources Sheet View, Resources USage View o 
Resources Allocation View, aparecen con un signo de precaución. 
 

 
 

5.4 Medición de los avances 
 

Tener cuidado con no ignorar lo siguiente: 

 ¿Está produciendo la estrategia los resultados esperados? 

 ¿Se están evitando problemas que puedan bloquear el proyecto? 

 ¿Permanece enfocado el equipo de trabajo, es productivo? 

 ¿Continúan teniendo interés en el proyecto las partes interesadas? 

 Si el proyecto es exitoso, ¿logrará los resultados esperados? 
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No se debe sobre controlar los detalles, se debe enfocar a obtener el éxito no la 

perfección. La revisión de los puntos de control (milestones) con obsesión y toma de 

decisiones es calve para el éxito del proyecto. 

 

En las revisiones contestar las preguntas siguientes: 

 ¿Qué problemas se han encontrado? 

 ¿Qué problemas se prevén? 

 ¿Cuál es la mayor preocupación hoy? 

 ¿Cómo podría cambiar esto el futuro? 

 ¿Cómo va el proyecto? 

 

Establecer una línea base o de referencia 
Sirve para comparar la situación de los planes contra los eventos reales. 

Tools > Tracking > Save base line > Entire project 

Se pueden establecer líneas base para las diferentes tareas específicas. 

 

Ingreso de fechas reales de inicio y terminación de tareas 
View > Tracking Gant 

 

Abrir una ventana inferior con la barra de división en la parte inferior de la pantalla, 

Dar dos Clicks en este ícono para abrir una pantalla inferior. 

 

 ir a la pantalla inferior y activarla More Views   abrir el menú de   seleccionar la Task 

Details Form y aplicarla. 
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Introducir los datos reales de duración de las actividades o porcentaje de avance. 

 
 

La gráfica de Gantt queda como sigue: 

 

 
 

También se pueden actualizar los avances en: 

 

View > Table tracking > Tracking 
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Otra forma para actualizar el avance de tareas específicas es con: 

Tools  > Tracking > Update task 

 

 
 

Otra opción es usando el botón TRACK y seleccionar la opción adecuada: 
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Para actualizar el proyecto ejecutar las instrucciones siguientes: 

Tools  > Tracking > Update project 

 
 

 
 

De manera similar para actualizar los costos reales: 

Tools  > Task usage  

View > Table tracking > Usage  

 

 
 

Guardar el trabajo 
Para exportar el reporte en formato HTML para páginas Web se tiene: 
File > Save as    Save as Type Microsoft Excel or XML
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Seleccionar solo los campos necesarios a exportar: 
 

  
 

 
Para el caso de XML, indicar FILE > SAVE AS: 

 

 


